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The Zenas Case Management System

Make every effort to send Zenas the lawyer and
Apollos on their way, and see that they lack nothing.

– Titus 3:13 

I. Introduction

A. About this system

This distribution provides a case management system for a solo lawyer using
Quattro Pro (QP), WordPerfect (WP), and other tools of the WordPerfect Office
suite, along with several other freeware tools available on the internet.  This
system serves my purposes as a lawyer in Georgia handling appeals and similar
issues in civil litigation, mostly including personal injury litigation.  Since the user
may wish to modify it in various ways to serve other purposes, this document
includes instructions on how this system works and how to modify it.

Evolving work in progress.  This spreadsheet has been a work in progress for
many years.  Some features could doubtlessly be improved, and others could be
added. If you have a suggestion for improvements, please e-mail them to me. 
Some parts have been re-written during the course of writing this documentation,
and though I have tried to update this paper to reflect those changes, it is possible
that there will be some minor discrepancies between this paper and the
spreadsheet. A full log of changes in the program is maintained in Logs:AI..AJ. 
The most current versions of these documents will be found at http://corklaw.com/
Tech/Zenas/. 

Public Domain.  This file and the accompanying files are placed in the public
domain for the benefit of lawyers and as examples to those who want to write
spreadsheet applications.  They are offered AS IS, without warranties of any sort. 
They work for me, but I make no guarantees about whether or how they will work
for you.  Use them at your own risk, and modify them at your own risk.  I offer
them at no charge, and for whatever value you may find in them.

You are welcome to revise this spreadsheet and accompanying materials to suit
your needs.  However, I strongly recommend that you (a) keep the original
documents unmodified and (b) backup working versions of each before you make
any substantial modifications.  You should become familiar with the programming
language and structure of these materials before attempting to alter them.  As
programmers know, a change in one place in the program may necessitate changes
in various other places. QP is also somewhat finicky about structural changes.
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CareWare.  If you find this distribution to be of benefit, I simply ask that you
remember the poor (Gal. 2:10) and consider giving to appropriate charitable
organizations for their relief.
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B. Contents of this Distribution

The files currently available online for this program are:

C Zenas.PDF - This documentation file.

C Zenas.QPW - the Quattro Pro notebook that functions as the case
management system at the center of the rest of these files.  I revise the
notebook from time to time and usually upload a current version each
weekend.  Information about the revisions is stored in columns AI and AJ on
the Logs page.

C TitlelogViewer.QPW - the Quattro Pro notebook for viewing time records
generated by Titlelog.

C ZenasMacros.Zip A zip file of PerfectScript macros containing:

ZenasClientFiles.wcm - Determines the full path and name of the client’s
folder

ZenasDiaryTime.wcm - Copies Zenas TimeSheet to the bottom of a WP
Diary file

ZenasFileFolders.wcm - Creates the client folder and default subfolders
when file is opened

ZenasMailMerge.wcm - Generates mailing envelopes

ZenasMerger.wcm - The main document assembly macro

ZenasMindMap.wcm - Opens (after creating, if necessary) a Freeplane
mindmap, and adds filed in client folder to it.  Serves as a file manager
as well as a mind map

ZenasPhoneNo.wcm - Given a phone number, it checks Zenas data to see
if the caller is in the system

ZenasPickActor.wcm - Allows user to pick a particular person in the
current case

ZenasPickCase.wcm - Allows user to choose case from database by name

ZenasPickList.wcm - Allows programmer to set a variable list of items for
the user to select

ZenasPickListedCases.wcm - Allows user to choose particular case after
a search narrows the list of cases (typically only the open cases)

ZenasPickPerson.wcm - Allows user to pick a particular person in the
database

ZenasShellExecute.wcm - Launches files as if clicked from Windows
explorer
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ZenasShowCase.wcm - Shows details on a particular case from the Case#

ZenasShowPerson.wcm - Shows details on a particular person from the
PNo

C ZenasForms.Zip - a zip file of templates, mostly WordPerfect WPT files

BoxSheet.wpt - basic case information for a sheet to affix to a banker’s
box

Caption.wpt - Legal pleading form for Georgia trial courts

Caption_NDGa.wpt - Legal pleading for the Northern District of Georgia
(federal)

CertificateOfService.wpt - form for a certificate of service

ClosedFileSheet.wpt - information on a file at time of closing

CoverLetterClerk.wpt - a cover letter to the clerk of the court

Envelope.frm - a blank envelope into which one or more addresses can be
merged

Envelope.wpt - a blank envelope into which one or more addresses can be
merged

FileLabels.wpt - a 1x7 set of labels for file folders

FileSheet.wpt - information on a file at time of file opening

Invoice.wpt - for compiling an invoice statement to clients

OperatingCheck.wpt - The form for checks on my operating account

TrustCheck.wpt - The form for checks on my operating account

Case_Template.mm - Freeplane mindmap default template for cases.

standard.mm - Freeplane mindmap that has default settings for all other
mindmaps.
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C. Programs Used

Corel WordPerfect Office. 

 Zenas.qpw was initially written using Corel’s Quattro Pro 11, and revised
under Quattro Pro X4, X5, X6, and X7.  Most files (forms and macros) in this
distribution are written in WordPerfect.  Images in this text are screen shots
taken with Alt+Printscreen, and these were then clipped and blurred using
Corel’s Presentations before incorporation into this manual.

This manual contains some information on how to use Quattro Pro.  For more
information on QP, WP or other software in this Office suite, see the tutorials and
help files for those programs.  In addition, help is also available in the Corel
newsgroups on Quattro Pro at cnews.corel.com, at Corel’s OfficeCommunity.com,
and at various forums of WordPerfect Universe at http://www.wpuniverse.com/,
particularly the “Other WordPerfect Office Programs,” “How do I?”, and “Macros
and Merges” forums.

External Programs.  

Zenas is written to work with an external mindmap and a time logger, both
freeware.  For the mindmap, I have used Freemind and now use Freeplane. 
Both function similarly; Freeplane has a few additional features, and in particular,
it works with a PerfectScript macro Zenas uses; whereas Freemind may crash if
the mindmap is large.  Upon starting this macro, Zenas gives the user the ability
to choose to add all new files in the client’s folder to the mindmap. In this way, the
mindmap serves as a file manager.  For a brief overview, see my short introduction
to the use of a mind map in a law practice.

For the time logger, I use Titlelog.  I use this mainly to reconstruct what I did
during the day, so that I can correctly attribute my time in Zenas’s TimeSheet.
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D. Troubleshooting

Macro seems to hang on first use.  

I have noticed that the first time I click a button that plays a PerfectScript
macro, the program and indeed my entire system appears to hang for 15 to 30
seconds, though afterward, the same button performed with the normal expected
speed. 

Cause: One cause of this phenomenon is that the WordPerfect PrintServer has
not been loaded, and it takes that period of time to load.  The PrintServer is
loaded automatically when WordPerfect is loaded and when PerfectScript is
loaded, but not when Quattro Pro is loaded.  When a PerfectScript macro is
invoked, the 15-30 second delay can occur while the PrintServer is being loaded. 
(The same will happen on the first loading of WordPerfect.)

Solution:  If that is the problem, it can be avoided in QP by making sure that
WordPerfect has already been loaded.  If the user wishes to solve the problem for
both WP and QP, one solution would be to put in one’s “Startup” folder a link to
a WP macro that simply beeps, as discussed at WordPerfect Universe.

Other troubleshooting tips will be added later, as the need becomes
apparent to me.
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II. How to use the Zenas.qpw Notebook

A. Read this before starting

You can begin using Zenas.qpw right away as a demo to test the program with
the dummy data that is pre-loaded.  However, to use it in your office setting with
real cases, you will need to make two categories of adjustments, which are detailed
below. 

First, you will need to enter data on your cases into it.  If you already have
some data stored in some other program, you may wish to import it into Zenas. 
Guidelines on how to set up your data for the easiest importation will be given
below.

Second, you will need to bring your file locations into harmony with Zenas’s
default locations.  That will require either that you move your file locations, or
change the places where Zenas looks for them, or some combination of both.

You may need or desire to change Zenas in other ways. Instructions for doing
so will be given in Part IV of this paper.

1. Importing your case data into Zenas

These are guidelines for the creation of a text file that Zenas can import and
then importing it.

Phase 1: Exporting to a text file.  

The ideal will be to create a text file with the same sequence of data as the
columns for data in Zenas.  For example, in Zenas’s database for attorney time,
the sequence is (1) Date, (2) (starting) Time, (3) Case#, (4) Hours, (5) Work (text),
and (6) Status.  A suitable text file would have numeric entries for each of these
columns except the fifth one, which would have a description of the work
performed enclosed. In order to let QP know where to break the line into separate
cells.  This calls for a character that is not used in the source data.  I usually use
} to do this.  Other good choices might be ̂  or ~, if they are not used in your text. 
A line from such a text file might look like this.

40878}0.75}1234}1.23}Draft complaint, research jurisdiction}0

Using this method involves a few additional steps, but it does cleanly import the
data.

Not all programs allow such flexibility in exporting data.  Experimentation may
be necessary to find the easiest way to import the data.

Dates and times can be especially tricky.  The ideal is to convert dates to
numbers, with day 0 representing December 30, 1899, day 1 as December 31,
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1899, day 2 as January 1, 1900, and so forth, which is how QP understands them. 
Times are fractional parts of days, so that Midnight is 0.0, 6:00AM is 0.25, noon
is 0.5, 6:00PM is 0.75, and so forth.  Your program may not be able to do this,
however.  If not, the next best is to export dates with slashes and quotes, such as
“12/01/2011”,1 and time such as “10:00AM”.  Such entries import directly as text
into Zenas, but as soon as you edit them, they become numbers.  This can be done,
apparently, by selecting the new data and copying it (Ctrl+C), then pasting it
(Ctrl+V) to the same location. 

Phase 2: Importing the text file into Zenas.  

These following steps are illustrated in the file ImportingData.pdf.  To import
the data:

1.  Place the cursor at the top left position where you desire to put the data. 

2.  Click the menu for Tools, Data Tools, Quickcolumns.  

3.  Use the file picker under “Text Source” to select the file.

4.  Then click the [Settings] button.  Uncheck the “Apply formatting to
spreadsheet” and “Set spreadsheet column widths and row height” choices. 
Deselect the Comma box under “End of Cell.” Select the Custom box and enter }
in it.

5.  Click [OK] twice, and the data should appear as expected in the Zenas
spreadsheet.

2. The Assumed Structure of the File System

The Zenas system assumes that the source files are kept on the hard drive of
a desktop or laptop computer of the solo lawyer, and thus on the C:\ drive.2  I store
client files as follows:

C:\Cases - the folder in which subfolders for all active cases are kept.  As of
2013, it also houses all of the Zenas files.  It also houses the executable for the

1 Note that a date exported with dashes rather than slashes will not import directly
into Zenas without some extra work. “12-01-2011” would be imported as the formula 12
minus 1 minus 2011.

2 Placing the files on a network, or making them otherwise available for multiple
users, involves some additional considerations. QP allows the notebooks to be shared by
selecting Tools > Workgroups > Sharing …. I have not experimented with this and
therefore offer no advice. If responsibility for cases is divided, the client database (if not
others) should be modified to indicate who is responsible, and the display pages need to
be modified to reflect responsibility.
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time logging program, as well as the Titlelog subfolder for its output.

C:\Cases\1234Smith - the subfolder in which files on case number 1234 are
kept.  After the number, I always enter one or more client names, which makes
things easier to find.  Zenas generates the following subfolders automatically, but
you can modify the macro (ZenasFileFolders.wcm) to suit your preferences: Dox
(documents); Drafts (where my WordPerfect legal pleadings are stored); Letters
(letters, memos, bills); Record (where as-filed pleadings are stored); Res
(Research).  

C:\Cases\Zenas - the subfolder where the Zenas files will be located.

C:\Cases\Zenas\Macros - where perfectscript macros for the Zenas files will
be located.

C:\Cases\Zenas\Forms - where forms and templates for the Zenas files will
be located.

C:\Cases\Zenas\Temp - where temporary files that Zenas creates will be
located.

C:\Cases\Titlelog - the subfolder where the Zenas files will be located.

C:\Cases-X - Where closed files are kept.  C:\Cases-X\10 houses all of the
folders for client numbers 1000-1099; C:\Cases-X\11 does the same for client
numbers 1100-1199, and so on.  I move closed client folders to the C:\Cases-X\
subfolder simply to make the backup of active cases easier.  If that is not a concern
for you, you may leave everything under C:\Cases.

You may wish to store your files in some other way.  For advice and
instructions on changing the Zenas system to match some other method
(presumably your preferred method) of storing files, see  p. 79, below.
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B. Orientation to Zenas and QP

1. The Zenas window

Zenas.qpw is a Quattro Pro notebook, which is a collection of separate
spreadsheets or sheets.  You can use it just as any other spreadsheet program. 
This document will assume that you have some familiarity with spreadsheets and
entering data in them.  Here is what the front sheet of Zenas looks like:

The top three lines are the typical title bar, menu bar, and a tool bar.  (This
particular tool bar is my own creation rather than one of the default QP toolbars.)
The next line is an address bar and cell editor, the best place for editing large
formulas.

There follows the large area for displaying data.  You don’t see the usual grid
lines, column headers (A, B, C, etc.) at the top or row headers (1, 2, 3, etc.) along
the left margin because those have been turned off for this sheet, and most of the
sheets.  This area includes horizontal and vertical scroll bars.  The horizontal
scroll bar is on the right half of the bar above the bottom bar.  On the left half of
that bar, there are tools for navigating the various sheets of Zenas (or any other
QP notebook).  

The names of each of the sheets are on the tabs there (Zenas, CaseView,
Deadlines, etc.).  The tabs are color-coded to match each sheet.  Clicking on them
causes that sheet to display.  The direction buttons at the left of this line allow you
to scroll through those sheets, which is useful in this case, because there are some
25 sheets, and they cannot all fit in the named display.
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The bottom bar is an application bar.  The left part of it shows the QP files that
are open.  The rest of the information on it is more or less useful for normal
spreadsheet operations.

Color coding.  Note the color coding of the backgrounds of these worksheets,
the tabs for each of the pages (see the bottom left of these screen shots), and the
columns of macros governing each of the worksheets.  I have tried to link them to
make the associations between them easier.

Grouping of sheets.  Note that the sheets in this notebook are grouped together
by function.  The precise pages and groupings change over time, but the current
breakdown is:

C Interface pages, those which the user will primarily read, print, and mani-
pulate.  These are Zenas, CaseView (for obtaining all information on a case),
Deadlines, TimeSheet (for keeping each day’s time), Bill (for getting current
monetary status on each case), Contacts.

C Databases, the actual databases of information which is to be displayed by the
interface pages, reports, etc.  These pages are Cases, People (including
corporations, etc.), Actor (which links People to Cases), Lawyers (short notes
on contacts with lawyers or other people).

C Special-use pages.  These are CaseDiary (compiles all datable entries on a case),
Status (overview of next event on all open cases), Suits (listing all cases known
to be in suit), Problems (listing four different kinds of problems with open
cases), TEntry (for automatic rule-based ticklers/deadlines), TData (the
database for automated tickler/deadlines), and Logs (for storing various
information).

C Financial pages.  These are Book (the “Book of Business,” a financial report on
all open cases), Costs, Time, Billings, Operating (the main bank account), and
Trust (the lawyer’s Trust or IOLTA account).

C Technical pages.  Currently, the Macs page stores all of the macro scripts that
run Zenas.

Dates.  Zenas cells are spaced to display dates in the MM/DD/YY format, which
is the second option under Tools > Settings > Application > International > Date
Format.

2. Navigating in Zenas

As just mentioned, at the bottom left of each screen is a list of tabs.  You can
click on those to move from sheet to sheet.  You can also move around from sheet
to sheet with keystrokes as follows:

C Ctrl+Home takes the user to the first sheet (Zenas).  For that reason, the
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first sheet serves as a place from which to jump everywhere else.  Buttons on
the Zenas sheet (and on various other sheets) allow jumping to other sheets.

C Ctrl+PageDown takes the user to the next sheet.

C Ctrl+PageUp takes the user to the previous sheet.

Within a sheet, the user can get around by these keystrokes:

C Home take the user to the top left cell (Cell A1) in the sheet.

C Home, End, Home takes the user to the opposite end, the intersection of the
column with the last data and the row with the last data.

C End, ArrowKey (Up, Down, Left, Right) takes the user to the end of the
contiguous block of data if the starting point is a cell with data; or the first cell
with data (or the boundary of the spreadsheet) if the starting point is a blank
cell.

In addition to these keystrokes, which apply to all QP spreadsheets, several
navigation macros have been programmed.   They are listed on the first sheet
(Zenas) in columns P to R.   Currently, they consist of the following:

With the cursor
on

Press To do this:

A Case Number Ctrl+Shift+j Go to CaseView screen for that case

A Case Number Ctrl+Shift+b Go to the Bill screen for that case

A Case Number Ctrl+Shift+d Create a deadline for that case

A Case Number Ctrl+Shift+q Show data on the case in a popup box

A Case Number Ctrl+Shift+w Enter a time record on that case

A Person
Number

Ctrl+Shift+p Show data on that person/entity in a
popup box

(Any) Ctrl+Shift+c Get contact information on a
person/entity

3. Buttons in Zenas

All of the buttons in Zenas run macros (scripts of commands), which are
written on the Macs sheet.  To find the macro associated with a button, right-click
on the button, select Properties, and select the Macro tab.  The dialog will look
like this example, which shows that the macro script associated with this button
begins on the Macs sheet at cell C31.  (Macros are always enclosed in {} braces.)
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The user can add buttons by using the Insert > Form Controls > Push Button
menu and dragging a rectangle.  A button results.  The user right-clicks it and
selects Properties.  On the Macros tab, the user places the beginning cell of the
macro script within braces.  On the Label Text tab, the user types the words that
should be shown on the face of the button.  Then click OK.

4. Manually adding to, and deleting from, Databases – A
Warning.

The user must be careful about manually adding or deleting rows of data from
any of the Zenas database.   Important parts of the spreadsheet may lie to the
right of the database; deleting the entire row would delete that, and inserting a
row would create a gap that could affect the performance of Zenas.   In addition,
inserting and deleting rows causes QP to recalculate the size of certain named
ranges, and consistency in their size is important.  Therefore, take heed of these
rules:

1.  Where Zenas has a means for automatically adding data to, or deleting data
from, a database, the automated means should be used.  

2.  The best method for inserting a line of data in a database is often to add it
to the bottom of the database and then to use Zenas to sort the database.

3.  The best method for deleting a line in a database is to select each cell in the
row to be deleted, press [Delete], and then use Zenas to sort the database.

4.  Whatever you do, don’t insert an entire row, and don’t delete an entire row.
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C. Annual Maintenance

At the start of each year, I do two things.  First, I save the spreadsheet in its
year-end state with a name like Zenas2012.qpw.  

Second, back in Zenas.qpw, I purge data from the databases that relates to
closed cases.  To do so, I place the cursor at the top of a column of case numbers
and invoke the macro at Macs:Z18.  This goes down the list and places an x at the
beginning of each case number that is no longer open.  I then sort the records by
case number and quickly delete all entries for closed cases.  I then re-sort by case
number, which eliminates the gaps between records.
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III. The Zenas Notebook

A. Zenas - Title Sheet, Case List, and Jumping Station

This shows Zenas, the first and title sheet of the notebook, which can always
be accessed from anywhere in the spreadsheet by [Ctrl+Home].  Its purpose is to
allow the user to move quickly to any page and to get information on any client
quickly.

The buttons on the left take the user to the pages indicated.  The rest of the
screen contains lists of active, semi-active, and recently closed cases.  The user can
get various information on a client by clicking on a case number and pressing a
button.  The [-> Client] button brings up case information on that client.  the [->
Bill] button brings up financial information on the case.

How to get a current list of cases.  

Press the [List Cases] button.  This will generate a current listing of cases in
the database in three separate categories, which the user may well wish to modify. 
(To modify it, see p. 83.) The first listing represents active cases, and the second
listing represents semi-active cases.

The distinction between active and semi-active cases turns on whether there
is a special entry in the Status column (Column J) of the Cases sheet.  If that
column is empty, Zenas assumes that the case is active.  To put a case into the
semi-active category, I place an explanation into the Status column.  Such
explanations include “Awaiting ruling” (when briefing has been done and nothing
remains but for a court to make a dispositive ruling, which is not expected soon),
“Consult” (in which I am assisting another lawyer on an “as needed” basis),
“Ref’d” (when I refer a case to another lawyer but keep it open to monitor), etc. 
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The third column shows recently closed cases.  The program lists any case
closed in the past 180 days.  This can be increased or decreased, as shown at p. 83.

These work for me to reflect all of the cases I am likely to be concerned with
on the first screen of information, so that I don’t have to scroll.  This may not be
the case for a different lawyer, and it may therefore me more useful to modify the
program to show, say, cases opened more than 180 days ago in the first column,
and cases opened less than 180 days ago in the second.  This can be done, as
shown at p. 83.

How to search for a particular case in the entire database.  

Press the [Search] button, which uses one technique for finding matches in the
database; a different method is used on the next sheet.

The steps are illustrated in the help file SearchForCase_Method1.pdf.

(Another way to search for cases, using a PerfectScript macro, will be discussed
in connection with [Search for Client] button on the CaseView page.)

How to view information about a particular case.  

There are two methods.

C Place the cursor on the desired case number here and click the [-> Client]
button.  

C Place the cursor on the desired case number anywhere in the notebook and
press [Ctrl+Shift+J] (for “jump”).

Both methods invoke a macro that takes you to the CaseView sheet on the
chosen case.

How to view financial information about a particular case.  

There are again two methods.

C Place the cursor on the desired case number here and click the [-> Bill]
button.  

C Place the cursor on the desired case number anywhere in the notebook and
press [Ctrl+Shift+B] (for “bill”).

Both methods invoke a macro that takes you to the Bill sheet on the chosen
case.

How to see who has a phone number.  

If you want to check to see if a phone number (or part of one) belongs to a
person in the People database:

1.  Click the [Phone #] button.  

2.  You will get a box in which to enter all or part of a phone number.  When
done, press [OK].

18

file:///|//SearchForCase_Method1.pdf


3.  The spreadsheet searches for matches in three columns (Phone1, Phone2,
and Phone3) of the People database.  (To make these searches most useful, phone
number should be entered with the same format; I suggest using periods in place
of dashes and parentheses.) If there is no match, you will get a message saying so. 
If there is a match, you will be taken to an area on the People sheet where
matches are listed.

Additional Benefit: This button runs the ZenasPhoneNo macro.  By
placing an icon to that macro on the desktop and adding a shortcut key to
it (right-clicking the macro, selecting Properties and Shortcut), as long as
Zenas is open, I can determine if a particular incoming call is in the Zenas
database.

How to go to the folder where Zenas stores files.  

Click the [Zenas Dir].  button.

How to go to other pages of the Zenas notebook.  

The other buttons take the user to the other sheets of the notebook.  They are
grouped into:

C Interface sheets (CaseView, Deadlines, TimeSheet, Bill, Contacts), which
are the ones that the user will mostly use to get information out of Zenas
and regularly add to it.  These sheets are placed in the first part of the
notebook, and their tabs should also be visible in the bottom left of the
Zenas window.

C Database sheets (Cases, People, Actors, Contacts), where most of the data
are stored (though deadlines and financial data are stored on those pages).

C Money sheets (Costs/Expenses, Attorney Time, Billings, the Operating
Account, and the Trust Account).

C Misc.  other sheets.

These will be explained in more detail below.

How to save the Zenas notebook.  

The File > Save menu item and the associated icon on the toolbar work.  QP
works with temporary files, and sometimes (rarely) the title bar will reflect
something like QP0000.qpw rather than Zenas.QPW.  There may be no harm in
ignoring the temporary file, but just in case, I use a button at the bottom left
called [Save File].  The macro is set to save it in the default location,
C:\Cases\Zenas\Zenas.qpw.  That can be changed by changing the contents of
Macs:C123.
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B. CaseView - The Main Page for Individual Cases

This picture shows CaseView, the main worksheet for viewing and modifying
information about a case.  It is also the place where new cases are opened and
existing cases are closed.

Zenas pulls this information directly from the databases.  

! The case information across the top comes directly from the Cases database,
specifically on the row that begins with the Case# (here 1934).  

! The deadlines in the bottom right come directly from the Deadlines database;
every entry on the present case in the Deadlines database should be displayed
here.

! The information on people connected with the case appears in the bottom
left comes from the People database via the Actor database.  

The Actor database (shown to the right,
using case 1822 as an example) is the glue
that binds people to cases.  Zenas looks for
each entry on the case in the Actor
database, and looks up telephone and email
information on the person in the People
database by using the PNo.  The last two
columns (Set and Role) define how that
person is related to the case.  Persons
directly connected with the client (here,
CLI and REF, for the client and the
referring lawyer) are given set 1.  The first
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set of opponents (usually DEF or PLA) get set 4, the second get 5, and so forth. 
Witnesses, judges, and others will typically get higher set numbers.  This list
remains sorted.  All people connected with a set are kept together, and thus the
screen will show that the ATT for set 4 is the attorney for the first opponent, etc. 
Names and phone numbers are thus sorted with the most important numbers at
the top of the list.

1. Navigating

At the top left there are navigation buttons.  As one might expect, [<] moves
to the preceding case (the one with the next lower number), and [>] moves to the
next case.  [|<<] moves to the first case in the database, and [>>|] moves to the
last case.

Below those are two buttons that navigate active cases, [a<] which goes to the
preceding active case, and [>a] which goes to the next active case.

To move directly to a case known by its Case#, click the [Get Case#] button. 
Enter the Case# into the dialog box that opens up.

To move to a case known by a name, click the [Search for Client] button.  

The steps are illustrated in the help file SearchForCase_Method2.pdf.

2. How to open new cases

In overview, you will enter data on the new case on the next blank line in the
Cases database, and Zenas will display it.  Zenas will also create the folder for this
case on your hard drive, some subfolders for it, and some default files for it.

The steps are illustrated in the help file OpeningNewFile.pdf.  

You may then create whatever normal forms that you want to create; I
automate that process with additional buttons on the CaseView screen.  Add
people and deadlines using buttons on the same screen.

For example, if you were to create a case on John Smith, follow these steps.

1.  Press the [New Case] button.

2.  You will be taken to the first blank row in the Cases database, and some
data will already be filled in.  You will get a reminder not to use the Enter key
until you have filled in all of the data that you know at the time.  After you click
[OK] on this reminder, the row will look like this (broken into two parts for
purposes of display here):
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The program assigns the next Case# in column A and the Closed# of 0 (formatted
here to three decimal points for reasons explained above in connection with
storage of closed cases) in column B.  Zenas considers a file closed if there is a
positive number in column B, but open if the number is zero.  It places today’s
date in columns F and I, which deal with the date the file is opened and the date
of last action on the case, respectively.  It places the cursor in column D for
naming the client.

3.  Fill in the remaining data, to the extent that it is known, and press [Enter]. 

In the Client field, I typically put the client’s last name first, then first name,
then a referring lawyer or other connected person in parentheses.  

In the Type field, I would place something like “Appeal” or “Med Mal Consult”
or “ERISA,” etc.  Use whatever names are meaningful to you.

The D/CoA field is for the date the cause of action arose (when the wreck
occurred, or when the contract was broken, etc.).  It is the starting date for filing
suit within a period of time.  QP allows you to enter dates in our familiar m/d/y
format, and it will (a) convert that entry into the five-digit number that QP
associates with that date, and (b) display it in the format shown above, if the cell
is formatted to show the number as a date (which can be done by pressing [F12],
selecting the Numeric Format tab, choosing Date in the left column, and Long Dat
Intl in the right column).

The Stat field is for the Statute of Limitations, which are almost always
expressed in periods of years.  Therefore, enter the number of years for the period
of limitation.  In Georgia personal injury actions, for example, the period is
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generally 2.  Zenas will use this number and the D/CoA number to calculate
deadlines.

The Status column defines whether the case is Active or Semi-Active.  If this
field is blank, Zenas treats the case as Active; if the file is open, it will appear in
the leftmost column of cases on the Zenas sheet.  I enter a textual explanation in
this field to demote the case to semi-active status (appearing in the second column
of cases on the Zenas sheet).  I use “Consult” or “As Needed” when I am helping
another lawyer.  I use “Awaiting decision” when the case has been submitted to
the court for what is likely to be an extended period of time, with nothing
happening in the meanwhile.  If I refer a case out that I continue to monitor, I
might type “Ref’d to John Smith.”

If the case is already in suit, I fill in the Ct, DocketNo and D/Filing fields.

In the Fee field, I use either a number reflecting an hourly rate, or an
abbreviation.  “C1/3+c” would reflect a contingent fee of 1/3 plus costs.  If an
hourly rate applies, Zenas takes this number to generate bills.  If I don’t yet know
what the fee arrangement will be, I type a question mark.

4.  After entering all of that data and pressing [Enter], the user gets a dialog
box in which to enter the name of the subfolder to be created in the c:\Cases\
folder.  It suggests a name, beginning with the file number.  If the folder begins
with the case number, Zenas will automate various things.  After typing the
desired folder name, the user presses [OK] or [Enter].

5.  The user is returned to the CaseView screen for the newly created case.  A
reminder message appears, advising the user to add parties, to add deadlines, to
create file labels, and to create an email folder in my email program for emails on
this case.  (On deactivating or changing informational messages, see p. 82.) [File
Label] and [Case Forms] buttons on the right of the screen generate the
paperwork I want.

3. How to close cases

Follow these steps to close a case.  The steps are also illustrated in the help file
ClosingFile.pdf.  

1.  Start by showing the case to be closed on the CaseView sheet.

2.  Click the [Close Case] button.  This takes you to a place on the Logs sheet
showing closed file boxes (column Y), and the last numbered file in each one.

3.  With that information, you enter Closed# to be used for that file.  Click
[OK].  (On deactivating or changing informational messages, see p. 82.) Type in
a number and press [Enter].

In my system, this number is a composite of a box number (in which the
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paperwork is placed), and an item number.  For example, the number 18.002
means that this file can be found in box 18, and it is the second item in that box.

4.  Zenas makes adjustments to the Cases database, and returns to the
CaseView, showing now the Closed#, the date of closing (today), and above the
case number, the word “CLOSED” appears.  The user gets a reminder message
to move the case folder to an archive folder (in my system; you may leave it where
it is if you please) and to move the physical file to storage.  Click [OK].

5.  Finally, if there are deadlines on the case in the Deadlines database, Zenas
marks them “Done” as of this date.  That is described in connection with the
Deadlines sheet, which is discussed beginning at p. 32.

In most cases involving physical files, I hand-write the Closed Case # onto the
folder before putting it into the storage box.  In some case that involve little or no
paper, however, I don’t waste a folder on the case.  Instead, at this point, I use the
[Case Forms] button to generate a single sheet of paper in WordPerfect with
pertinent case information, including the Closed Case #, and I put that into the
storage box.

4. How to reopen cases

1.  Start by showing the case to be reopened on the CaseView sheet.

2.  Click the [Reopen Case] button.  That button appears in place of the [Close
Case] button if the case displayed has already been closed.

5. How to add people to the case

In overview, you will type all or part of the last name to see if the person is
already in the database.  If so, selecting the person works.  If not, you will be given
the option to add the person to the database, and if you choose to do so, you will
be taken to a blank line in the People database to type data on that person.  If you
select or add a person, you will finally be asked to define how that person relates
to this case in the Actor database.  After this, you will be returned to the CaseView
sheet, which will show the addition you have made.  

The steps are also illustrated in the help file AddingActors.pdf.  

Phase 1: Listing possibilities in the People database.  

Just as there are two methods for finding a case, there are two methods for
finding a person.  Zenas currently uses the PerfectScript macro method starting
at Macs:F44, which calls ZenasPickPerson.wcm.  The earlier QP-based method
starts at Macs:F4.  If you prefer that one, you may change where the [AddPerson]
button points.
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Here is a detailed example, assuming that you want to add John Smith to this
case:

First, click the [Add Person] button, and the Choose Person dialog box will
open.  Type in the last name, “Smith” in this instance, and click [OK].  (In the
case of a corporation, any part of the name will do.) Zenas will list every person
(including “artificial” persons like corporations) in the People database.  Here is
what the result might look like.

Phase 2: Selecting or adding the correct person.  

If the correct person is listed as already in the database, you will select that
person (Phase 2A).  If not, you will need to add that person to the People database
(Phase 2B).

Phase 2A - Selecting a person already in the People database.  

If the person is already in the database, select that person and click the [Select]
button.  You will move on to Phase 3.

Phase 2B - Adding a new person to the People database.  

If the correct person is not listed, click the [Add New] button.  You will be
taken to the first blank row of the People database, with a new PNo inserted and
the name (in this example, “Smith”) inserted.  Fill out the rest of the information
on that row.  It will look like this (with the single horizontal line broken into two
segments for readability):
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LName is the last name.  Hon is the title of address (Mr., Ms., Hon.  Dr., etc.).  Sr
includes (Sr., Jr., III, IV, etc.) Three lines for a mailing address are A1, A2, and
A3; fill them in that order.  City, State and Zip are self-explanatory, as should be
Email.  (Be watchful, though, that the zip code is treated like text and not like a
mathematical formula.) 

When adding a corporation or other entity to this list, enter the full name in
the LName field only.

Three possible phone numbers are allowed.  These formerly represented the
home phone, work phone, and “other” (fax) line, but with the prevalence of cell
phones, these can be used in any order that works for you.  To be more helpful, I
now add a “c”, “h,” “w” or “f” after numbers to refer to cell, home, work, and fax
lines.  In order to facilitate searching phone numbers, I recommend that you use
one consistent method of dividing numbers.  I use only periods (e.g.,
404.123.4567), not dashes (not 404-123-4567) and not parentheses (not (404)123-
4567).

For entering corporations or other legal entities, use only the LName column,
and ignore FName, Hon and Sr.

After you finish entering that data, press [Enter] to proceed to the Phase 3.

Phase 3 - Linking the person to the case in the Actor database.  

At this stage, two small dialog boxes will appear.  In the first, you will assign
John Smith a Set number to position him in the final display.  In the second, you
will assign a Role designation.  In this sample, I assigned him to Set #1 (usually
the client or those closely linked with the client), and assigned him the role of
“REF,” which signifies a person who refers the client to me.

As for the Set number, you can use any consistent system that makes sense for
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you, but because I want the most important information at the top of the list, I
assign first priority to clients and the other lawyers on my side of the case.  

As for the Role designation, to conserve horizontal space, I try to use a three
letter designation to tell me what I need.  The following chart is my default
system, but it is flexible to accommodate needed changes.

Set (Significance) Role

1 Client and lawyers on my
side of the case

CLI (client); REF (referring attorney);
ATT (attorney)

2 (Rare) other persons
closely connected with my
side of the case 

3 Co-Parties 3DP (third party); COP/COD (Co-plaintiff,
co-defendant)

4 First set of opponents DEF (defendant, if I’m on the plaintiff’s
side); PLA (plaintiff, if I’m on the
defendant’s side); ATT (attorney); INS
(Insurer); ADJ (adjuster)

5 Second set of opponents,
etc.

Same.

8 Witnesses WIT (witness); EXP (expert)

9 Judicial personnel CLK (Clerk); JDG (Judge)

After entering the Set and Role, press [Enter] to return to the CaseView page,
where the person has been added.

6. Changing data on the Case or People

Using the Edit Record button, you can easily change data on the case or people
connected with it.  The steps are illustrated in the help file ChangingData.pdf.  

How to edit the case data shown on this sheet.  

Click on any of the information fields on the top half of the CaseView field and
then click the [Edit Record] button.  This takes you to the line in the Cases
database on the current case, and to the cell in it for the field that you chose. 
Make your changes to this data.  Conclude by pressing [Enter] to return.

For example, if after filing suit you can fill in the information in the top right,
click on the blank where Court information is shown and press [Edit Record]. 
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This will take the user to column K of the Cases database, which relates to the
court in which the case is pending (pictured at left).  Enter the court, the docket
number, and the date the suit was filed in Columns K, L and M, and then press
[Enter].  The changes should appear back in the CaseView menu.

How to edit data on people shown on this case.  

Find the person whose data is to be changed on the CaseView sheet and click
the Name or the Contact Info on that row.  Then click the [Edit Record] button. 
This takes you to the row in the People database on the chosen person.  Make
your changes to this data.  Conclude by pressing [Enter] to return.

How to change the Set and Role of an Actor.  

Find the person whose data is to be changed on the CaseView sheet and click
the Set or Row cell on that row.  Then click the [Edit Record] button.  This takes
you to the row in the Actor database on the chosen person.  Make your changes
to this data.  Conclude by pressing [Enter] to return.

7. Generating Pleadings and Other Forms on this Case

The WordPerfect Office system allows the user to perform document assembly,
taking information in the databases on the current case and generating
documents in WordPerfect, mostly using WordPerfect’s merge feature.

By pressing the [Case Forms] button, the user gets a selection of forms to
generate.  These include paperwork on the file that I find useful, as well as a
caption for initiating legal pleadings.  For information on how to modify this list
in a way suitable for your use, see the discussion below at p. 77.

8. Other functions

How to show all information in the People database on each person
listed on the sheet.  

(1) Click anywhere on the line of information about the person whose data is
to be shown.  (2) Then click the [Get Actor’s Info] button.  This will pull up a
window containing all of the information in the People database, headed by a
mailing address suitable for letters.

Additional information about such persons is available on the Contacts sheet,
which provides a complete list of all cases with which that person has been
involved, and all other contacts that you record concerning that person.  See the
discussion below at p. 44.  To get this information automatically, (1) click
anywhere on the line of information about the person whose data is to be shown. 
(2) Then click the [Check Contacts] button.  This would be a way to perform a
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conflicts check (though most sole practitioners have a good recollection of their
clients and adversaries).

How to send an email to a particular person listed on the sheet.  

Click anywhere on the line of information about a person whose email address
is shown.  Then click the [Send to One] button.  This will pull up your default
email program, with the email address in the “To” line and the case name in the
“Subject” line (which you should consider editing).

How to send an email to more than one person listed on the sheet.  

Click the [Send Multiple] button.  This takes you to the Actor page.  Follow the
directions on p. 50.  These steps are illustrated in the help file
EmailingMultipleActors.pdf.

How to print envelopes for multiple people listed on the sheet.  

Click the [Send Multiple] button.  This takes you to the Actor page.  Again,
follow the directions on p. 50.

How to log time on this case.  

Simply press the [Log Time] button.  This will take you to the TimeSheet
worksheet, and start an entry for this date, at this time, with this client number. 
The TimeSheet is discussed below at p. 37.

How to add a deadline or reminder on this case.  

Simply press the [Add Deadline] button.  This will take you to the first blank
line of the Deadlines worksheet, and start an entry for this date, at this time, with
this client number.  The TimeSheet is discussed below at p. 37.

How to prepare a bill on this case.  

Clicking the [Get Bill] button will take the user to the Bill sheet and runs a
current balance statement.  That sheet can be used to generate a bill for the client. 
It is discussed below at p. 40.

How to get the current fee balance on this case.  

Clicking the [Get Balance] button will popup a message including the fees
earned on the case, as shown on Zenas’s Book page (the “Book of Business”),
which is discussed below at p. 67.

How to generate a history of all time spent on this case.  

This is a variation on preparing a bill.  Clicking the [All Work] button takes the
user to the Bill sheet and generates a statement of prior time in the case.  The Bill
sheet is discussed below at p. 40.

How to generate a diary on this case.  

Click the [º Case Diary] button, and Zenas will take you to the CaseDiary
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sheet, where it combines chronological information from the Cases, Time, Billings,
and Deadlines archive databases in chronological order.

How to open the folder of files on this case.  

Simply press the [Client Folder] button.  This assumes that you store your files
as indicated in Part II.A.1 on p. 10, above.  If you use a different file location,
please read the instructions on modifying file locations at p. 79, below.

How to open a mind map on this case.  

Simply press the [Mind Map] button.  This assumes that you store your files
as indicated in Part II.A.1 on p. 10, above.  If you use a different file location,
please read the instructions on modifying file locations at p. 79, below.  Clicking
the macro gives the user first the option of adding all new files in the client’s
folder to the mindmap.  In this way, the mindmap serves as a file manager.  

This is a view of a typical mindmap.  Here are some features:

! New files are added to a node at the bottom called “New Files.” They can be
drug from there to any other node.  

! Clicking on the red arrow on any of those nodes brings up the document
referred to there.

! The combination of the last two features allows this to serve as a file
manager.

! Once open, clicking on a node “unfolds” (opens) it if it is “folded,” or “folds”
(closes) it if is “unfolded.” So, clicking on the “Record” node in this example will
either open up or close an array of nodes on various parts of the record in the case,
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some of which are folded and some not.

! Parallel nodes can be added, and subnodes can be added.

! The nodes are color coded, with our side’s documents in green, the opposing
side’s in red, and the court’s in yellow, and neutral persons in blue, as seen here.

! More detailed nodes can be added.

! Arrows can be added to connect nodes at remote distances, as seen here:

For a brief overview of other uses of mind maps in a legal practice, see my short
introduction to the use of a mind map in a law practice.
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C. Deadlines - The Main Sheet and Database for Deadlines

This shows the main sheet for viewing and entering information on deadlines. 
It is not just the interface to the database; it is the database for deadlines.  Unlike
the other interface pages (CaseView, Contacts, Bill), this database needs the most
regular viewing and hands-on modifications, which functions are combined here.

What this shows.  

The Case#, Client, and Event fields should be self-explanatory.  

The Due field is the deadline for the deadline.  It is a mathematical formula
that adds the date in the Trigger, Days, and Vary fields.  The formula should not
be altered.

The Done field is for manually inserting the date on which a deadline was
performed.  It is entered prior to using the macro to place this deadline in an
archive log of deadlines done.

The Trigger field is the base for time calculations.  It is either the event that
starts a deadline running, or it is the deadline itself.  If it starts the deadline
running, the number of days allowed should be put into the Days column.  The
Vary column can then change the result of that calculation.  Here are some
examples:

C If you have a hearing on 9/1/12, place 9/1/12 into the Trigger column.  If you
want this deadline to come up three days in advance of that hearing in order
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to remind you to prepare, place -3 in the Vary column.

C If you have 30 days to respond to a motion served on 9/1/12, place 9/1/12 into
the Trigger column and 30 into the Days column.  If you want this reminder
to come up a week earlier (to start working on it), place a -7 into the Vary
column.

C If you later get a two-week extension to respond to the last motion, you could
either add 14 to the Days column or simply replace the Trigger and Days
entries with the new deadline in the Trigger column alone.

The two right-most columns in red on the gray background calculate the days
until (since) the deadline, on the left, and give a more graphic representation of
the same on the right.  For every day past a deadline, the right formula prints one
“x” for each day past the deadline.

At the top right of this view, there is a line that shows today’s date.  I often use
this in entering dates rather than checking the calendar by other means.

1. Adding Generic Deadlines

There are several ways to add deadlines to this listing.

C Manually.  If you choose to do so, go to the first blank row, enter all the
information (including copying the formula cell in the Due column), and then
sort the database.

C Case#.  Place the cursor on any case number anywhere in the notebook, and
press [Ctrl+Shift+D].  This takes the user to the bottom of the deadline
database, enters the case number, client name, and formula for the due date. 
It gives instructions for finishing the data entry.  When finished, press [Enter].

C On the CaseView Sheet.  Press the [Add Deadline] button, which does the same
as Case# method, except that it treats the current case number and client
name on the CaseView sheet as the data to enter into the Deadlines database.

C Add New Deadline Button.  

1. Click the [Add New Deadline] button.  

2. You will be taken to the Zenas sheet to select a case.  Place your cursor
on the Case# and press [Enter].  

3. You will be taken back to the Deadline sheet for manual entry of the
Event and date data.  When done, press [Enter].

2.  Adding Rule-Based Deadlines

This method sets deadlines for rule-based deadlines, such as deadlines for filing
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suit, conducting discovery, responding to discovery, responding to motions,
handling appeals, and anything else with a normal deadline.  In overview, after
selecting the case number, you will go to a screen on which to select a category
and subcategory of deadlines, and type in the triggering date.  Zenas will add
appropriate deadlines to the Deadlines database.  This uses deadlines that are pre-
calculated on the TData sheet.

These steps are illustrated in the help file AddingRuleBasedDeadlines.pdf.  

1.  Click the [Rule-Based Deadlines] button.

2.  You will be taken to the Zenas sheet to select a case.  Place your cursor on
the Case# and press [Enter].  

3.  You will be taken to column A of the TEntry sheet.  Zenas reads from the
TData sheet the major categories of deadlines in the A column, categories such as
“Presuit,” “Suit filed,” “Discovery,” and so on.  These will be listed in the W
column.  Select the appropriate category and press [Enter].

4.  You will then be taken to column B on the same sheet.  Zenas will read and
list the subcategories from Column B of the TData sheet.  Select the appropriate
category and press [Enter].

5.  You will then be taken to cell C4 on the same sheet to enter the triggering
date.

For example, if you want to apply for certiorari from an unfavorable ruling by
the Georgia Court of Appeals in a particular case, you would follow those steps,
selecting “Georgia Appeals” under Categories in the A column, “Cert Petition”
under Subcategories in the B column, and then enter the date of the adverse
ruling in C4, as shown in the image on the right.

6.  Zenas enters all relevant deadlines on this case.  It does so by locating the
correct row on the TData sheet and then calculating up to ten deadlines flowing
from the trigger date.  In the example just given, the correct row is row 38 for the
“Cert Petition” deadlines.  Zenas takes the text of the three deadlines from cells
D38, F38 and H38, the accompanying deadline-offsets (10 and 20 days) from E38,
G38, and I38, and calculates the deadlines for certain events to occur.

3. Customizing the rule-based deadlines

You are free to modify the standard deadlines on the TData or add to the
listing.  To do so:

1.  Establish major categories of deadlines in Column A.  This is done primarily
for convenient viewing.  Without major categories, the user might have to scroll
down fifty entries before finding the correct one.  Using major categories makes
the user’s job easier.
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2.  Set subcategories in Column B.  Each subcategory should convey to the user
the set of deadlines that Zenas will generate.  Each will be paired with one
triggering event (in column C) and from one to ten separate deadlines (columns
C to W).

3.  State the triggering event in Column C.  This text will be used to identify
the date that the user should enter into the Y4 cell on the Deadlines page.

4.  Starting with the first deadline in columns D and E, enter the text that will
appear in the deadline (column D) and the offset date (column E).  Repeat for the
second deadline, with text in column F and offset date in column G.  Continue
laterally until all deadlines generated from the same triggering event are set out. 
As for calculating the offset date:

A.  Many times, the exact offset is set by rule, such as 30 days for discovery
responses.  I enter 30 as the offset, and ignore weekends and the extra 3-days
allowed for mailed pleadings, but you are free to change this.

B.  Sometimes, the deadline is specified in terms of a number of months or
years.  In that case, use the @amnths function.  For instance, if the trigger date
is place in TData:F1, a deadline that is two years later can be determined by the
function @amnths(F1,24), which calculates the date 24 months (2 years) after the
date in F1.  To calculate the exact offset, the formula @amnths(F1,24)-F1 gives
the correct result.  

C.  More detailed calculations of deadlines can be attained by more complex
date formulas.  See the QP Functions guide for Date formulas, including some like
@Workday, @IsBDay and @NBday formulas that can address deadlines that fall
on non-business days.  I find that I do not need that level of precision.

4. Other Functions

How to Sort the Deadlines.  

Zenas offers two methods of automating the sorting of deadlines.  Using the
[Sort-Date] button, deadlines are sorted by date first and case number second. 
The picture above shows the result of such a sort.  By clicking the [Sort-Case]
button, the user may also sort the database by case number (so that all deadlines
on each case are grouped together), and secondarily by date.

How to Remove Old Deadlines.  

You can manually remove deadlines by deleting the line of data (from Case#
on the left to Vary on the right) and sorting the deadlines.  However, I prefer to
keep a log of deadlines that are Done, both to show when I did work, and to keep
track of how long it takes for various Courts to rule on appeals, motions, etc.  To
do this:
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1.  Place the date on which the Deadline was accomplished (or the court ruled,
etc.) in the Done column;

2.  Place the cursor on that date; and 

3.  Press the [Deadline Done] button.

This moves the Deadline to the Logs sheet.  (You can visit the Logs sheet by
clicking the [Old Deadlines] button.)

How to keep up with your deadlines.  

Check them daily.  Zenas has a macro that plays automatically when the file
is opened.  This is located at Macs:a133.  It automatically takes the user to the
Deadlines sheet as the first item.

You should also regularly (at least weekly) run the Caseload Progress Report
to detect any cases for which there is no deadline.

You should also regularly (at least weekly) sort the Deadline database by Case#
and go down the list, adding deadlines where they are required.

How to use the Caseload Status Report.

On a separate page called Status, there is a table which I call the “Caseload
Status Report.” To go to it immediately, click the [Status Report º] button.  To
get a current report, click the [Update Report] button on the Status page.

This report lists all open matters (including the pro bono matters that I give
numbers below 1000), and it shows the next deadline, if there is one, or ERR if
there is none.

If an entry shows ERR, this case is a potential problem.  The computer does
not reflect that the lawyer will refer to the case again.  To avoid this, I try to have
at least one deadline for each open case, even if it is a monthly or quarterly
deadline (“Mcheck” or “Qcheck”, respectively) to “check status” on a case on
which I am consulting.  And since I check the Deadlines daily, this ensures that
no case will slip into a crack.

I also print this report occasionally (every 1-2 weeks).  The printed report gives
an ongoing status of work and I use the paper copy to write out a prioritized list
of major tasks, which I cross out when done.
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D. TimeSheet - recording daily time

This shows the main area for entering daily time.

In short, the user enters data in the yellow area.  Zenas then places the data into
the sheet below in correct temporal sequence.  The blue column on the left
calculates the time on each item.  Two numbers on the upper right side total the
time spent on cases (entries in the Case# column greater than or equal to 1000)
and on pro bono cases (entries in the Case# column greater than 0 and less than
10000).  At the end of the day, the user presses the [Post Time] button, which
posts time on all cases (entries with a Case# greater than zero) to the Time
database.  This macro also saves the data to a WordPerfect file that is called
C:\Cases\Diary.wpd.

These steps are illustrated in the help file UsingTheTimeSheet.pdf.  

The number in the Time column may reflect 0-59 seconds, but the display of
this number is rounded to the nearest whole minute.

This system does not support other timekeeping practices, such as billing in
units of tenths (or quarters) of hours, which tend to record more time than the
user actually spent.

When the user types a Case#, Zenas shows the name of case in the space below
the Case# as a means to ensure that you attribute time to the right case.

How to enter time in the timesheet.  

There are various methods of entering time records in this sheet.

Method 1.  The user can manually type data into the white sheet, but that can
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get data out of order.  The [Sort] button at the top will restore the correct order. 
For routine entries, I recommend the following methods instead.

Method 2.  The user can manually type data in the yellow area, and then press
the [Add this Item] button, which will place the data from the yellow area in its
correct position in the white data.  This has the advantage in most cases of having
the date already supplied.

Method 3.  The user can press the [Now] button, which places today’s date in
the Date column, the current time in the Time column.  Then, the user types the
Case# and Work information, after which the user presses [Add this Item].

Method 4.  From the CaseView screen, the user presses the [Log Time] button. 
This behaves as the [Now] button does, with the addition of the Case# from the
CaseView sheet.

Method 5.  Click on any cell containing a Case#, and then press
[Control+Shift+W].  This behaves as the [Now] button does, with the addition of
contents of the starting cell as the Case#.  How to designate time as AM
or PM.  

Time can be entered as AM time simply by typing the number.  For example,
the program treats an entry of 10:30 as 10:30 AM.  

Time entered as PM time requires more.  For example, to enter 3:30 in the
afternoon, the user may type 3:30 PM, 3:30PM, or 15:30.

How to get the case number for entry in the timesheet.  

That is what the Zenas page is for.  Just click the Zenas tab at the bottom left,
find the correct case number, and return to the TimeSheet page to enter this
number.

How to calculate the last time entry in the day.  

The formulas in the left, blue column calculate the time for an entry by
comparing the time on the same row with the time on the next row.  Since there
is no entry below the last entry in the day, no duration is shown in the left
column.  If this were posted to the Time database now, no time would be recorded
there for this work.  

To deal with this, press the [End of Day] button.  This will fill the yellow data
entry cells with the current time, a 0 case number, and “End” in the Work field. 
If you need to adjust the Time entry, do so here.  Then press [Add this Item].  This
will place the entry at the bottom of the time sheet.  The time sheet will now be
ready for finalizing and posting.

Getting the correct times before posting.  

At the end of the day, I frequently remember things I did without inserting
them into the timesheet.  A Work entry that started as one thing may morph
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many times, and my entry in the Work column will need to be expanded. 
Additional items come from, inter alia, scanning emails in my “Sent Mail” folder,
other notes, and a Log file that Zenas keeps on the Logs sheet at columns M-Q.  

I also use a time logger called Titlelog, which stores information about each
window title that one accesses in a CSV file for each day.  When I try to remember
what I did in the day, I click the [Titlelog Data].  Doing so opens the current day’s
file of entries, highlighting places where I sent an email.  I use this to make or
correct time entries in the time sheet.  When I have finished, I close the Titlelog
file without saving it.

The [Titlelog Yesterday] button does the same thing for the previous day’s
data.

The [Titlelog Folder] button takes the user to the folder where Titlelog stores
its CSV files, so that you can get older data there.

How to adjust times and entries before posting.  

If you must adjust the timesheet before posting, there are several ways to do
so.

For simple alterations, manually editing the timesheet is the best and only
way.

For inserting missing rows, I do not recommend manually inserting rows, for
reasons explained at p. 14.  Instead, use either of the manual methods for time
entry that are described above, using the [Sort] button where necessary.

How to post time to Time database. 

Only after the user has finished entering time and adjusting the timesheet to
ensure accuracy, the user may post time to the permanent database.  This is done
by pressing the [Post Time] button.  The user will get a warning to be sure that
the entries are ready to post to final records.  

Upon clicking Yes, the data on regular and pro bono cases (where the Case#
is greater than 0) is saved to the Zenas sheet called Time.  Then, the time sheet
will be copied to a WordPerfect file called c:\cases\Diary.wpd.  The macro then
clears the timesheet for use the next day.
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E. Bill - Accounting on Each Case

The Zenas notebook deals with the business end as well, and this Bill sheet is
the primary interface for the economics of individual cases. 

1. The Client Bill Interface Sheet

This sheet enables the user to calculate current balances (or obtain other
financial information) on particular cases, from the Time, Costs, and Billings
databases.  The user may generate bills in WordPerfect from this page and update
the databases to reflect when billings have been issued and when they have been
paid.

The sheet places the data from relevant databases in the three blocks on the
bottom of the screen.  Those reports are generated by making selections of the
client and starting date in the top left center, and then choosing a type of report
from the two buttons on the top leftmost column.  The sheet summarizes that
data in blocks in the top center and top right of the screen.  The sheet also
contains seven navigation buttons and three buttons for billing and keeping
accounts current.

How to generate financial reports on a case.  

There are several ways in which to generate financial reports:

C Case#.  Place the cursor on any case number anywhere in the notebook, and
press [Ctrl+Shift+B].  This inserts the Case# into the yellow field in the Bill
worksheet and runs the Unbilled report.

C On the CaseView Sheet.  Press the [Get Bill] button, which does the same as
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Case# method, except that it treats the current case number and client name
on the CaseView sheet as the data to enter into the Bill worksheet and runs
the Unbilled report.  Alternatively, press the [All Work] button, which does the
same, but runs the All report.

C Manually.  Type the Case# into the yellow field marked Case# on the Bill
worksheet and select one of the five Report options by clicking the
corresponding button on the left.  In the rare instances in which the user
wants to start the billing from a particular date, that date should be entered
in the yellow field marked Start.

What financial reports are available.  

Two financial reports are available by pushing a button on the top left of the
screen.  For purposes of generating bills, the selection “Unbilled” is the most
pertinent, and it is the default.

Unbilled.  This generates a listing of all hours and costs suitable for generating
a bill in WordPerfect.  It lists hours and costs that have not been marked “billed”
or “paid” in the bottom blocks and totals those items in the top center.  It adds the
total together.  The result is ready to be converted into a bill by clicking either the
[Draft Bill] or [Final Bill] buttons.  

All.  This itemizes all hours and costs relative to this Case, whether billed or
not.

Understanding this system: “billed” and “unbilled” items.  

The basis for this system of keeping the account with the client correct rests
on correctly setting one of two “status” numbers to each entry in the Time and
Costs databases.  When these items are initially entered, their status is usually left
blank, which is equivalent to 0 in Zenas.  When they are billed, they are assigned
the number 1.  In rendering the “Unbilled” report, Zenas will count only time and
costs with a blank status, and only those will show up in the two blocks at the
bottom left of the Bill page.

This system is set up so that time and cost items are given a status of 1 only
when a Final Bill is prepared, using the [Final Bill] button.  It is possible to change
the status of each item manually, but that should not normally be necessary.

Understanding this system: Billings.  

Zenas keeps records of account balances in the Billings database.  Payments
received are to be entered by clicking the [Record Payment] button, which will
store a payment as a negative number in that database.  Clicking the [Final Bill]
button will, in addition to generating a Bill/Invoice/Statement of Account
(synonymous terms as I understand them) in WordPerfect, will add a line to the
Billings database calculating the new amount earned and current balance (which
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will usually be the same, but for many reasons may not be).3

2. How to Record Payments

When a payment is received, or any other credit is to be given against the
amount that the client owes, enter those payments by clicking the [Record
Payment] button.  You will then be asked the amount of the payment and the date
of the payment.  The amount of the payment will be stored as a negative number,
and the date will be stored, along with a current balance, in the Billings database. 
After entering a payment, Zenas will update the display of the Bill page.

3. Handling the Billing

There are many possible ways to accomplish the task of sending Zenas/QP data
to WordPerfect.  I have settled on a method that uses a PerfectScript macro to
open a WordPerfect template, take data from Zenas.qpw and directly insert it into
the template.  

The following steps are illustrated in the help file HandlingBilling.pdf.

How to prepare Zenas to generate billing statements to send to
clients.  

Before using the Print Bill Macro the first time, you will want to replace or
modify the bill template Invoice.wpt.  That document has my letterhead and
taxpayer ID on it, which you must change for your own use.  You can create a
totally different format, but it is recommended that you keep a backup of the
original files while engaging in trial and error with your forms.

How to generate billing statements.  

You can use various methods to generate a billing statement, but this method
does so very quickly.  (This assumes that you have followed the steps to prepare
Zenas to generate billing statements, as just explained.)

1.  Generate an unbilled report on the case, as described above.

2.  Make any modifications to the time and costs on the Bill worksheet.  The
reason for doing it now is that Zenas will calculate the amounts due and store
them.  Waiting to make adjustments in WordPerfect would require coming back
to Quattro Pro to store the data manually.  Making adjustments to the numbers
in WordPerfect could easily cause totals to be wrong, and thus need adjustment
in WordPerfect.

3 In earlier versions of Zenas, the user was required to approve these additions
manually. Under this system, that is no longer required.
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3.  In addition, if there are credits to be given, as where the client has made an
interim payment, or where some portion of trust funds are to be used, the user
should treat them as payments (see “How to Record Payments” above) first, and
then they will be properly accounted on the final invoice.

4.  To see a test run of the bill, without committing it to a final version, click
the [Draft Bill] button.  This will generate an invoice/statement of account in
WordPerfect.  After reviewing it, close that file (since any later file will have to
have the same name).

5.  Continue making modifications on the Bill worksheet until the draft bill is
as desired.

6.  When you are ready to commit all of the numbers to final form, click the
[Final Bill] button.  This will (a) create an invoice in WordPerfect; (b) change the
status on all time and cost items associated with this Case# to 1; (c) create a new
entry in the Billings database with the current balance; and (d) update the display
on the Bill page, so that all entries for time and costs disappear, replaced by a new
entry of the amount billed.

4. Misc.  Functions

How to navigate from the Bill worksheet.  

The user can jump to the three databases by clicking the [-> Time Data], [->
Costs Data], or [-> Billings Data] buttons.  

The user jumps to the “Book of Business” by clicking the [Financial Report
(Book) ->] button.  

The user can jump to the two overall accounts by clicking the [-> Operating]
or [-> IOLTA] buttons.  

The user can jump to the CaseView screen for this case by pressing [<-
CaseView].  The user can also jump to the folder of electronic documents by
pressing [Client Folder].

How to set the default hourly rate.  

Zenas calculates the value of time, other than hourly-rate cases, using the
“default hourly rate.” This number can be found in Macs:B9.  To change the
number used here, change the number in that cell.
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F. Contacts - Conflicts and Other Relations

This is the main page for viewing information on people in your database.  It
is therefore useful for checking for conflicts (though most Solos have no real
trouble with this) and interactions with others.  I use it mostly for seeing what I
have done with other lawyers.  When you get old and deal with many people, this
is good.

The basic idea is that you ask for information on a person in the database, and
this screen gives you the main contact information.

What this shows.  

The top left of the screen shows the contact information for the particular
person, as stored in the People database.  

The bottom left of the screen searches the Actor database to find every case in
which the person has been involved, and pulls basic information about the case
from the Cases database.

The bottom right of the screen looks through the Lawyer database4 and returns
every entry that you have input, with the most recent entries on top.  Each entry
takes the form of a Contact Type, Details, and Follow-up (if any).  You should

4 This could really relate to contacts with anyone in the People database, whether
lawyers or non-lawyers, but because 99% of my entries in this category are with other
lawyers, that is what I call it.
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think of this as a set of interactions or communications, not a set of people, the
common meaning of a “Contact.” This is a “contact” as an event, not a person.

The top right of the screen is the main way to input entries into the Lawyer
database.

How to get contact information.  

By pressing the [Get Contact Info] button, you get the same dialog box for
selecting a person shown above at p. 25.  Type in the last name and press [OK]. 
If the correct name does not appear, press [Cancel], but if it does, select the name
and press [Select].

You can do the same on the CaseView page by selecting a person shown there
and clicking the [Check Contacts] button.

Zenas then pulls contact information on the person from the People database
into cells in the upper left, case information from the Cases database into the
lower left, and contact information from the Lawyer database on the lower right.

How to edit the person’s personal information.  

The [Edit Contact] button invokes a macro that takes you to the line of
information about this person in the People database.  When you make any appro-
priate changes and press [Enter], you are returned to the Contacts screen.

How to add a communication/interaction with the person.  

You may want to add contacts with someone who is in your People database. 
You don’t need to add such interactions if the person is added to a case, but if you
have contacts with the person in some other way, you may want to make a record
of it.  I do so for email inquiries, interactions on listserves, telephone calls, etc.

Method 1: To enter new listings in the Lawyer database, place your cursor in
the yellow cells in the top right.  Enter the date, type of contact,5 details, and
results if any in the yellow block of cells, and then press the [Add Contact Data]
button.  Zenas enters the line in the Lawyer database and updates the display in
the bottom right of this screen.

Method 2: Manually enter data into the Lawyer database.  Since that requires
knowing the Pno for this person, it is a rare case in which this method would be
desirable.

How to update or modify a communication/interaction with the
person.  

5 To standardize the entry of “Contact” types, I have hidden common types in the cells below
“Contact” so that one or two keystrokes will automatically place the desired text in the Contact
cell, using QP’s QuickType feature.
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To change any of those listings (in particular, to add “results” to an existing
line), find the listing in the white field below “Other Contacts” in the bottom right
of the screen.  Make your changes there.  Make sure that you have selected one
of the cells you changed, and then click the [Update Contact Data] button.  This
will find the line in the Lawyer Database and make it match the contact
information for the line of the cell that you selected.

How to send email to this person.  

The [Send Email ->] button sends an e-mail to the current person’s email
address.

How to make an envelope addressed to this person.  

The [Envelope ->] button sends an e-mail to the current person’s email
address.

How to jump to the data source.  

To jump immediately to the Lawyer database, press the [-> Lawyer Data]
button.
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G. The Main Databases

The next set of pages house the main databases for the notebook.  Each has a
common structure.  The database begins in cell A1.  Row 1 contains the headers
or field names for each database.  Those rows are “locked” (using View > Locked
Titles), and QuickFilters (using Tools > QuickFilters) are applied.  The data en-
tries appear below.  In the Cases and People databases, a unique number is placed
in column A by which the correct record can be most easily identified and found. 
For columns that expect to receive only labels (e.g., telephone numbers and street
addresses) or dates, I select the column and apply the appropriate “constraint”
([F12]/Selection Properties > Constraints).

1. The Cases database and sheet

The Cases database was already discussed above in connection with the
CaseView screen, starting at p. 20, particularly regarding the closing and opening
of cases.

To the right of the Cases database, there is a block of cells that is useful for
slightly more complex querying of the database by macro.6  This technique has
already been used in connection with the [Search] button on the Zenas page, as
discussed above on p. 18.

Note the structure in Cases:W1..Z3.  The Criteria Table for a search of the
Cases database is in the top two rows of this table (W1..Z2).  However, only formu-
las are placed in W2..Z2, and these refer to the text in W3..Z3.  The formulas in
W2..Z2 are masked because they are precisely written to enable more complex

6 To query a QP database manually, use the Tools > Data Tools > Notebook Query
menu.
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searching of the database, and masking gives a visible sign not to write other
search terms there.  

Thus, the user can easily enter names, types of cases, etc.  into W3..Z3, press
[Search Cases], and the formulas in W2..Z2 will correctly render them for typical
purposes of searching, with the output generated in the rows starting with
W7..Z7.  In the example shown here, placing “Appeal” into the “Type” field at Y3
causes the query to list all cases in which the word “appeal” appears anywhere in
the “Type” of case category.  The formulas also allow greater flexibility.  The
formula in U2 allows the user to put “o” in U3 to select only open cases, or “x” to
select only closed cases.
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2. The People database and sheet

The People database was also discussed above, in connection with adding
people to the CaseView screen on a case.  See particularly p. 26, above.

To the right of that database is a block containing three search methods, one
for name and city, one for phone number, and one for email address, which looks
like this.

To search for a name and city, enter all or parts of either into the yellow fields
at AA3..AE3 and press [Search People].  Matches will appear in AA7..AE7 and
below.

To search for people with a phone number, click the [Search Phone Numbers]
button.  An inputbox will appear, asking for all or part of a phone number.  Enter
the (partial) number.  Zenas will show any matches for the (partial) phone number
that appear in any of the three columns for phone numbers in the People
database.  Therefore, it is important to use the same format for all entries of
phone numbers in the People database.  This button also appears on the Zenas
main page, for quick access when a phone call comes in.7

To search for people with an email address, click the [Search Email Addressess]
button first.  An inputbox will appear, asking for all or part of the email address. 
Enter the (partial) address.  That (partial) address will appear in the yellow field,
and Zenas will show any matches in the same space.  Here, the last search looked
for the email segment “smith,” and it returned eighteen names with “smith”
somewhere in the username or in the domain name.

7 As a development of this, I put a shortcut to the ZenasPhoneNo.wcm macro on my
windows desktop and assigned a keystroke shortcut to that macro.  Thus, even if Zenas
is not open, I can invoke the macro, type in a partial phone number, and Zenas will open
with a search for persons with that partial phone number in its database.
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3. The Actor database and sheet

The Actor database was also discussed above in connection with generating the
parties involved with the case on the lower left side of the CaseView screen, above
at p. 20.  The concepts of an Actor’s Set and Role were also discussed in
connection with adding a person to a case, above at p. 26.  This database provides
the “glue” that links the cases with the people and businesses.  Columns A..D
contain that glue, and by keeping it correctly sorted by Case# and Set, it keeps all
of the records straight on the CaseView page.  Macros automatically enter records
when people and businesses are added in the CaseView screen and then keep them
properly sorted.

I have not coded the removal of records (as where the wrong person is
incorrectly added to a case or no longer involved with it).  That must be done
manually, or you may try your hand at coding it.  When manually deleting or
inserting rows, remember the caution noted above at p. 14.

If you are uncertain which person or business a particular PNo refers to, select
that cell and press [Ctrl+Shift+P].  A window will pop up showing information
from the People database.  If you are uncertain which case a Case# refers to,
select it and press [Ctrl+Shift+Q].  Another window will pop up showing
information from the Cases database.

How to list relevant actors.  

To the right of the database, there is another search form.  It allows you to list
all persons who have any connections with your cases based on the search criteria
you enter in the yellow cells.  

Typing a case number into L3 limits the search to people involved with a case;
leaving it blank searches in all cases.  The search can be narrowed by putting one
or more Role into O3.  This example finds everyone connected with Case# 1825
that is either a referral source (REF) or an attorney (ATT), when those terms are
placed in the yellow cells and the [List Actors] button is clicked.  The macro also
provides the name and email address of the persons selected.

Pressing the [Mail Merge in WP] button uses my envelope template to make
envelopes in WordPerfect for those same people.  If you don’t want to make an
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envelope for everyone listed, delete the PNo entry in the M column for all persons
to be excluded.

Pressing the [Email All] button generates email addresses in the Q column for
those actors, which addresses can be copied into an outgoing email.  These steps
are illustrated in the help file EmailingMultipleActors.pdf.  Note, however, that
the initial font (currently Arial 8) governing the first cell (currently Actor:P7) will
usually appear to govern the first addressee.  This is an annoyance in the transfer,
as noted here, but it is easily fixed by deleting the codes imported from QP.  I
usually backspace twice.
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4. The Lawyers database and sheet

The Lawyers database should be thought of as a “Contact-Event” database, for
reasons explained above at p. 44 in connection with the Contacts sheet, but 99.9%
of my contact-events are with Lawyers.  Hence, the name.

This tells me that I had contact with the people in the A column on the date in the
B column.  The type of contact is given in the C column (with “Direct Q” being
generally a call or email directed to me and a “List Q” being an email to a email
listserv that I answered.  There are a few other categories as well, such as when
I contact them, when they mention me to others, etc.  A quick summary is stored
in column D, and any follow-up is stored in column E.

As in other cases, if you want to know which person a particular PNo refers to,
select that cell and press [Ctrl+Shift+P].  A window will pop up showing
information from the People database.

To the right of the Lawyers database, there is another block for searching
contact-events.  You can limit it by type of contact by entering some term in O3,
but the main use will be to search for a term in each contact.  In this example, I
searched for the term “sj” (summary judgment) by entering sj in P3 and clicking
the [Search Lawyers] button.  This listed every contact-event in the database in
which sj occurs in reverse chronological order (most recent listings at the top). 
There are also formulas in the R column to identify the person making the contact
by name.
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H. Reports and Utility Sheets

The sheets between the databases and the financial sheets are places where
reports and utility programs appear.  Several have already been addressed.

1. Case Diary

The CaseDiary sheet compiles all events in the Zenas databases on each case. 
Click the [Generate Diary on this Case] button, and Zenas will take you to the
CaseDiary sheet, where it combines chronological information from the Cases,
Time, Billings, and Deadlines archive databases in chronological order.

53



2. Status Report

This report lists all open matters (including the pro bono matters that I give
numbers below 1000), and it shows the next deadline, if there is one, or ERR if
there is none.  This is discussed in more detail above at p. 36.
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3. Suits

Another utility program is one that lists the Court-related data on each active
case that is in suit.  Clicking the [List Suits] button gives a listing that is suitable
for further processing.
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4. Problem Cases

The Problem Cases list is intended to list four kinds of cases that might be
problematic.  A weekly check of this list should help address any problems before
they arise.  Note that this program is set for problems arising out of Georgia’s civil
procedure rules, and therefore you should consider altering it if you need different
information.

By pressing the [Problem Case Report] button, Zenas gives information in
these four categories:

1.  Statute of Limitations.  

This block lists every active case (treating these as having a Case# of 1000 or
greater and no Closed#) in the Cases database in which the statute of limitation
(calculated from the date of the cause of action under D/CoA and the number of
years under Stat) would expire within 60 days (or has already expired).  

It will also list each case in which a date of cause of action or statute date are
unknown, so if the case may involve litigation, this listing will encourage an early
determination of the litigation deadlines.

Litigation deadlines are not suitable for every case, of course, for a number of
reasons.  In order to avoid such cases being listed as Problem Cases, you may place
a text explanation in the Stat column (such as “n/a”) for that case.  Zenas will
then ignore it when generating this list.

2.  Cases Not in Suit.  

The Cases Not in Suit list is very similar in function to the Statute of Limita-
tions list.  Its slightly different orientation is to advise you that a case is more than
two years old without a suit being filed (and unknown dates of the Cause of Action
will result in a listing here).  It is thus an extra check against a suit languishing,
even if the statute of limitation has not run.

And as with the Statute of Limitations list, a text explanation in the Stat
column such as “n/a” will prevent the case from being listed here too.

3.  Five Year Rule.  

There is a rule of Georgia practice that a case in suit in which no order has
been taken in five years is automatically dismissed, without further action by the
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parties or court.  For each case that is in suit, this determines the point that is five
years after the date the suit is filed (D/Filing) or the date of the last order
(D/LastOrder), whichever is later, and if that date will run in the next 180 days,
the case is listed.  

That user may prevent this case from being listed by entering a later date in
the D/LastOrder column.  And if there is no later order from the court, the user
will have ample time to get the case ready for trial or to obtain an order from the
trial court that would start the five year period running again.

4.  Inactive Cases.  

The last block shows cases in which Zenas records no activity in the prior 180
days, as shown in the D/LastAxn column of the Cases database.  The point is to
avoid cases languishing.  Zenas automatically updates that entry when the case
is opened, when the user marks a deadline done on the Deadlines page, when the
user sends an email from the CaseView page, or when the user opens the mind
map from the CaseView page.  You may, of course, change the macro to allow
more or less time, and other routines could be set to update this field of the Cases
database.
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5. TEntry and TData rules for deadlines

These two pages supply the interface for adding rule-based ticklers and the
rules, respectively.

On the TEntry page, the user will select from categories and subcategories of
ticklers/deadlines and then enter a starting date.  These steps are illustrated in
the help file AddingRuleBasedDeadlines.pdf.  

The categories and subcategories come from the TData page, which appears
below.

The TData sheet has already been discussed in connection with the entry of
rule-based deadlines, starting on p. 33.  The macro that generates deadlines lists
categories from Column A, and upon the selection of one of them, gives its
subcategories in Column B.  Upon the selection of one of them, the user is asked
about the triggering date of the event in Column C associated with the chosen
subcategory.  It takes that date and calculates all offset dates on the same row and
then enters each deadline with its offset on the Deadlines page.

Thus, to create a new deadline, find a suitable category in column A or create
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your own.  Add enough detail to the subcategory in column B to let you know
when to choose it.  Put the text calling for the triggering date in Column C.  (I use
“D/” to mean the “Date of.”) Put the first deadline as you want it to appear on the
Deadlines page into the D column and either a number or a formula that
calculates the number of days in the E column.  Repeat the last two items for
every other deadline that can be calculated on the basis of the same triggering
event.

See also the discussion of modifying a rule-based deadline above at p. 34.
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6. Logs

I use the Logs sheet to store data on cases.

Columns A to H store deadlines that have been marked done by the [Deadline
Done] macro on the Deadlines page.  This preserves a record of when I dealt with
a deadline without leaving it on the Deadlines page.  These will be purged
annually.

Columns N to Q formerly stored the times during the day at which I select a
particular client.  The original idea was to use this log to help track my time on
cases, to assist with entries in the TimeSheet page.  It can still be used for that
purpose, but since implementing it, I use the Titlelog time tracker, as described
on p. 39.  To use it again, place calls to {Macs:R5} at strategic spots in the macros.

Columns S to W store the time it takes various courts to rule on various
matters, particularly appellate courts.  By sorting it with the [SortCtTurnaround]
button, I get a range of time in which to expect rulings.

Columns Y to AA store information about closed cases.  In particular, for each
box of closed cases, it calculates the latest date on which any of the files in the box
was closed.  Then, using a formula, it calculates the date four years later on which
the box may be purged.

Columns AI to AJ store details on changes made in the Zenas program.
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I. The Financial Databases

Turning to the databases having to do with money, I have found it convenient
to have five databases:

C Time - to keep track of the attorney’s time on cases.

C Costs - for all out-of-pocket costs on a case and other items (such as mileage)
that I want to remember when it is time to pay my taxes.

C Billings - to list billings and balances on each of the cases for which there are
such.  (Not for the typical contingent fee case.)

C Book - An overview of unbilled time spent, fees earned, costs, balances, and
recent billing history on each active case.

C Operating - this is essentially the business’s checking account.

C Trust - this is the business’s trust account.

In most respects, these should be straightforward, but I would call attention to the
following points and features.

1. The Time database

The Time database should be largely self-explanatory.  

The starting times are kept in the second column primarily to allow the records
to be sorted in correct temporal sequence.  These records come from the
TimeSheet page for every entry with a Case# greater than 0, and thus it includes
the pro bono cases that have numbers below 1000 in my system, as seen in the
third column.  

The final column, representing the “Status” (see discussion of “status”
beginning at p. 41 above) is set by macro when the user submits a bill (the macro
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marks it as “1”) by clicking the [Final Bill] button on the Bill page (see p. 40).  A
blank in that column indicates that no bill has been prepared.

The data on this page may be sorted chronologically by pressing the [Sort
Time] button or sorted by Case Number, using the [Sort Cases] button.

To the right of this data, there is an area for getting a listing of all unbilled
hourly fee time, generated by clicking the [Detail Unbilled Hourly Time] button.

I wrote this report to help me decide whether time billed was significant enough
to warrant sending a bill.
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2. The Costs database and sheet

This database is intended to be a complete listing of the costs of doing business. 
It serves two particular purposes:

C It is where I store all costs that should be charged to a client.  The Bill page
looks through the data in this database to determine what the client has and
has not paid when preparing a bill.

C It is where I store all other expenses that I want to track for tax purposes.  A
macro on the Operating account page automatically adds items to this
database.  You must add everything else on this page.  In my case, this is
mainly mileage, things paid for in cash, credit card, or from the personal
checking account.

Costs should be entered as they are incurred.  Where the cost relates to normal
operations rather than a case, use “0” instead of the case number.  

Mileage distances are calculated using MapQuest, and mileage rates are
determined by multiplying the distance by the variable MileageRate, the current
rate approved by the IRS and stored in cell P7.  I typically do not charge the client
for the mileage for short runs (say, to the post office), and therefore I enter a “1”
as the status code (see discussion of “status” beginning at p. 41 above) so that the
client is not charged for it, though I certainly want to note it for tax purposes.

Standard Costs.  

To make certain repetitive cost entries easier, click the [Standard Costs]
button.  Doing so takes you to a place to the right of the database (T1..X25) where
common costs are kept.  Select the cost entry (entries) and press [Enter].  The
numbers are entered into the database.  You should freely modify these cost
entries to include your repetitive cost entries.
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Purging data.  

You may not need to purge data in this Time Database or the Costs Database,
but I do so annually.  At the end of a calendar year, I save the notebook with a
designation like Zenas_2011.qpw.  After that, I return to Zenas.qpw and sort the
time database by case.  I select entries for each case that has been closed and press
the [Delete] key.8  I do likewise for Cost items that are not related to a case.  I then
re-sort it by Date and Time to return to its normal, chronological order.

8 Do NOT select the entire row and press delete, because data to the right of the
database may be deleted. See the discussion at p. 14.
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3. The Billings database and sheet

The Billings database keeps a history of the payment status on cases.

At the time of billing.  

As you generate bills on the Bill page (see discussion beginning on p. 40), Zenas
generates entries at the bottom of this list.  In addition to the date, Case# and
Client name, this entry includes the new fees and costs earned (Column D), the
letters “Stm” (for Statement) (Column E), and the current account balance
(Column F).  Usually, the entry in columns D and F will be identical because the
starting balance is $0, but they easily may not be.  (There may be an unpaid prior
bill, or the client may have prepaid for services.) The number in Column F will be
the bottom-line amount that the client owes, and it should be equal to all of the
positive and negative numbers on the same Case# in the Billings database.

There is also a search block to the right of the Billings database.  

You can limit the search in various ways, as by setting a starting (earliest) date for
billings in the yellow cell under Date, or seeking only a particular Case# to get the
full history on one case.  Then clicking the [Search Billings] button yields results
below.

Further to the right, you can get a listing of unpaid billings by clicking the
[Outstanding Bills] button.
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A button on the initial screen of this sheet will also generate this report and move
the user to a point to see it.
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4. The Book of Business: Financial Report on All Cases

The user can obtain an overview of the financial situation on all open cases,
commonly called the “Book of Business,” on the Book page.

How to generate this report.  

Pressing the [Update Report] button generates this overview of active cases
quickly.  The top of the report shows totals, broken down by whether the case is
contingent, uses one’s default hourly rate, or “other.” The bottom of the report
shows the critical numbers on each open case:

Case# and Client Name.  These come from the Cases database.

Hours.  The numbers in this column come from the Time database.  These
hours are all unbilled (i.e., the status number is 0).  This means that they reflect
all time in contingent fee cases, in which no billing is typically sent, but they
represent only time spent after the last billing for hourly-fee cases.  The purpose
of this different treatment is to see what the current value of the case is to the
practitioner.

Rate.  This item comes from the Cases database.

Fees.  If the item in the “Rate” column is a number, it is treated as an hourly
rate and multiplied by the number in the Hours column to generate the “Fee.” If
the item in the “Rate” column is not a number, then the default hourly rate is
used.  Thus, in the case of hourly-fee cases, this number represents an amount
that should ultimately be billed to the client and paid.  In non-hourly-fee cases,
and especially in contingent-fee cases, the number represents only the value of the
lawyer’s time to date, which can be used for informational purposes.
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Costs.  The numbers in this column come from the Costs database.  These costs
are all unbilled (i.e., the status number is 0).

Balance (Acct.  Bal.  now).  The numbers in this column come from the Billings
database.  They represent the current unpaid balance for the case, as reflected by
the sum of entries in column D of the Billings database.

Total Due (Total Earned now).  This is simply the mathematical sum of fees,
costs, and current balance for each case.

Symbols.  The next column places symbols ($ or c) if fees are currently earned
in hourly billable cases or if costs over $100 are outstanding in other cases,
respectively.

Last Bill (now Last Stmt).  The last column shows the date of the latest billing
on each case.

Past Due (now Age).  To the right of the grid, Zenas calculates the number of
days since the billing.  The larger the number, the longer the time since the bill,
and the greater concern about receiving payment.

The [Detailed Unbilled Hourly Time] button runs the report noted above at p.
62.
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5. The Operating Account and sheet

The Operating Account is essentially an electronic checkbook.  

Date, Check#, Case#, Other Pty, Income and Expense columns are
straightforward.  The Balance column contains formulas that calculate the then-
current balance.

The next-to-last column is for balancing this register against the monthly bank
statement, as explained below.

I also use this sheet to keep track of business income.  Therefore, I make an
entry on it even if a check coming in from a client, or a distribution from the Trust
account, goes directly to my personal account.  In those cases, I make an entry and
put the same amount in both the income and expense columns.  This does not
affect the balance in the far right column, but it allows Zenas to keep track of
business income.

How to write a check.  

Zenas allows you to use a macro to generate a check in WordPerfect for
printing.  

1.  Click on the row with the data which you want to convert to a check.  

2.  Press the [Write Check] button.  

3.  You get a confirmation request about whether you want to write that
particular check.  Click [Yes].

4.  You get an input box for the check’s Memo line.  Enter appropriate
information and click [OK].

5.  The Zenas macro (ZenasOperatingCheck.wcm) pulls up a WordPerfect
template (Check_Operating.wpt) and replaces codes with the data on this line of
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the Operating sheet.9

6.  Zenas asks if you want to place the payment into the Costs database.  Click
[Yes] or [No], as appropriate.

7.  Make any desired modifications in WordPerfect and print the check.

Adding entries to the Costs database.  

At the top of the screen, there are two buttons for adding entries to the Costs
database from the Operating account.  You can enter the amount of the check into
the Costs database by clicking on the row with the check and pressing the [Add
Expense to Case Costs/Deductions] button (you will be asked to add the “Purpose”
of the check).  You can enter the mileage of driving a deposit to the bank into the
Costs database by clicking on the row with the deposit and pressing the [Deposit
Mileage] button.

How to balance the checkbook with the bank statement.  

To the right of the check register, there are several formulas that help balance
the books and track income.  

To use this to balance accounts, when you receive/view a bank statement:

1.  Put a “1” in the column to the left of the balance for every item that appears
in the bank statement, and for every other “wash” transaction (void checks,
checks passing outside the operating account).

2.  Enter the balance on the banks statements in the first yellow cell shown on

9 Since my checks may well be of a different size and my printer may have different
capabilities from yours, you will probably need to change the check template before this is useful
to you.
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the right.  The balance should be $0 in the cell below it.  If it is not, you need to
do further work to balance them.

Keeping track of income.  

Below the area for balancing the checkbook, there are formulas for checking
income in the current year and for a selected year.  The formulas for the current
year return both the actual income and the income it would project for the end of
the year, if income continued at the same pace it already exhibited.

Search the Operating account.  

As in other cases, there is a way to search the Operating account.  By placing
dates and numbers or formulas in the yellow cells in the search block on the right
side of the Operating sheet and pressing the [Query Operating Acct] button, Zenas
returns matching records.  Some possible formulas are suggested below.

In this example, I wanted all expenses since January 1, 2014.  I typed the
starting date into the Date cell,, the formula +F2>0 under Expense (which
returns all positive entries in the F/Expense column), and 0 (or +E2=0) under
Income, which excludes lines where there is also income (otherwise, all the wash
transactions would be returned).

If I had wanted to limit the same output to expenses on cases, I would have
entered the formula +C2>0 under Case# (which is true for all entries in the C
column greater than 0).  This would have yielded only the line from 5/30/15 on
case 2005.
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6. The Trust Account and sheet

The Trust Account functions just like the Operating Account that was just
discussed.  

The same rules apply for entering data and using the next to the last column
to balance the checkbook.

One writes a check from the trust account the same way, by clicking a row and
then the [Write Trust Check] button.  The only differences are that (a) this
invokes a different macro (ZenasTrustCheck.wcm) and a different template
(Check_Trust.wpt), and (b) the macro knows that if the “Other Pty” is “CMC,”
it should substitute my full name on the payee line.  Naturally, you would modify
this macro to apply to your initials and name.  

You can enter the mileage of driving a deposit to the bank into the Costs
database by clicking on the row with the deposit and pressing the [Deposit
Mileage] button.

On the right of the Trust account electronic checkbook, there is a table for
calculating balances, both with the bank statement and with each client for whom
trust funds are held.
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How to balance this account with the bank statement.

To balance accounts with the bank, enter a 1 in the next to the last column of
every entry recognized in the bank statement, and enter the bank’s balance in the
yellow cell at the bottom of the table to the right.  The result should be $0, as it
is in the bottom left..

How to balance the account with each client.

To balance accounts with each client, enter the clients’ case numbers into the
yellow slots in the top right.  (If you hold funds for more than the 9 slots, the
formulas in that block can be copied down the page.) Zenas calculates the amount
deposited and disbursed for each such number and gives a total balance for each
client in the white cells next to the yellow cells.

The sum of those balances for each client appears at the top left as “Total in
Trust,” and the difference between that number and the bank account balance is
reported as “Extra in Account,” which should balance with middle left block of
income and expense unrelated to cases, as it does in this screen shot.

At the bottom right, there is a list of cases for which I held trust funds and
later disbursed them in total.  This is kept simply for my historical records.  Zenas
does not require that you keep them.
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J. Macros - How Zenas Thinks

The macros page, shown here, is where the QP scripts reside that run when
buttons are pushed.  (PerfectScript macros are stored elsewhere.) 

I cannot describe the details on each macro, which the reader is free to investigate,
but I will note here some of the finer points.  (Details on how to do some of the
programming are given below in Part IV.)

First, the reader will note that the macro sheet is color coded so that macros
on each of the other sheets can be more easily found here: the main background
color for each sheet is paired with the background color for the column(s) on this
macro sheet that relate to the buttons on each sheet.  Columns A and B are used
for general-purpose macros and data.  On sheets whose macros stretch over
several columns, such as the CaseView sheet whose macros are in columns D to
G, readability is increased by changing the color of the text from column to
column.  Grouping the macros together helps find and debug them.  When
working on a macro, its column is widened so that its content can be read.  When
I finish working on the macro, I return it to the narrow width above.  I leave a fair
amount of vertical space between macros so that, if I add lines to one macro, I do
not need to move the one below it.

Several other conventions are used.  A description of the macro appears at the
top of the macro in bold.  Cells in red are where calculated data are stored. 
Comments and documentation are typically placed in yellow (or some other
distinctive color) and/or italicized.
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This sheet has been compiled over a long period of time, and modifications will
probably continue to occur from time to time.  (A diary of changes appears at
Logs:AI1.)  This means that there are a number of macro writing techniques here. 
The dominant techniques are discussed in Part IV below.

Many of the macros start by invoking a macro at {Macs:b4}, and they conclude
with macros at {Macs:b3}.  This is a performance issue.  {Macs:b4} turns off the
redrawing of the screen while the macro is running,10 which speeds things up. 
After the macro is over, we want the screen to automatically update, so {Macs:b3}
reverses the effects of {Macs:b4}.

An earlier version of Zenas also applied manual recalculation (see the macro
at {Macs:b5}) with the same idea of speeding performance, subject to resetting
background recalculation — the normal state — at the end (see the macro at
{Macs:b6}).  This may have made a difference when Zenas used extensive
functions and formulas, but that no longer is the case, for reasons detailed shortly
below.  In further testing, it appears that Zenas reacts as quickly, if not faster,
without switching between manual and background modes of recalculation.

One issue in coding these macros is in choosing between referring to a named
cell or a cell address.  The difference is between coding a line such as {Branch
EditCase} or {EditCase} on the one hand, or {Branch Macs:G24} or {Macs:G24}. 
If all other things were equal, it would be better to used named cells because they
make the macro easier to understand, and because modifications of macros with
cell addresses require reviewing each line to make sure that the cell addresses are
still correct.  However, all things are not equal.  As you modify the notebook, and
especially when named cells are moved or the names deleted, Quattro Pro
sometimes fails to make the expected adjustments, and a sort of drift results, in
which a user looking at the formula would see it referring to the wrong named
range, although it correctly obtained data from the correct, originally-designated
range.  And on some occasions, the deletion of a named range can corrupt the
notebook.11  This is why I avoid almost all named ranges, and macros that

10 Even so, some macros do momentarily cause row and column headers to appear and
change during the execution of the macro.  I have not considered the momentarily
strange appearance sufficiently troubling to look deeply for a fix, assuming that a fix
exists.

11 QP developers, please take note of this too. These problems have been documented
and discussed at WP Universe here, here, here, and here. I have limited the use of named
ranges to shortcuts to macros. 

If you choose to use startup and shutdown macros, they must also be named
_nbstartmacro and _nbexitmacro, respectively. Places for macros are in cells Macs:B18
and Macs:B23. These are left blank in this distribution. In my personal copy, the macro
resets the view on each page, alerts me if time from the prior day on the TimeSheet page
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formerly used them have been modified in the past year or so to use static
addresses.  

In order to keep ranges static, I have attempted to hard code them.  They can
be hard-coded into the macro commands, but I find it easier to hard code them in
the block currently at Macs:A171..A198.  Those addresses can be invoked in a
macro by using the @@ function.  For example, @@(A171) returns the
coordinates of the Cases database, and it is used in many macros in lieu of hard-
coding the same block.  This makes it easier to change the dimensions of a
database: simply change the contents of the relevant cell.

Another feature of these macros is the level of detail used to take precise data
from a database and place it precisely on the screen.  Turning to the CaseView
screen, each time the screen is updated with a Case#, the macro elaborately places
bits of information from the Cases database across the top of the CaseView screen
using macro commands at Macs:D81..D94.  One may ask why I do not use many
formulas in those CaseView cells and almost everywhere else that they could be
used.  Those would be simpler, and I did so earlier, but I found two problems with
this approach.  First is the problem of named cell drift mentioned above: it would
be difficult to explain to a user (possibly like yourself) why the formula seems to
be pulling data from the wrong database, but it is actually returning correct data
from the correct database.  The second problem is that every time new data is
entered, all formulas in the entire spreadsheet are recalculated, and over time,
this slows the performance.

A related point is that I do not use notebook queries for most searches and
representation of data, such as the Actor Set and Role entries on the bottom left
of the CaseView screen or the Deadline entries on the bottom right, which are
instead generated with the macro commands at Macs:d100..d112 and Macs:
d126..d134, respectively.  The reason has to do with quirks in QP’s queries. 
Different configurations of queries can cause QP to return the wrong column, or
the wrong row of information.  Such quirks almost always go away when the file
is saved, QP is closed, and the file is reopened in QP, but nobody should have to
do that in order to get the correct information, particularly since Zenas is being
offered to people who may well want to add and delete columns of information for
their own purposes.  The method used here requires more programming, but it
yields fast, solid results.

has not been posted, and takes me to the Deadlines page.
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IV. Document Assembly
Zenas relies on a PerfectScript macro for document assembly.  It opens a

marked-up template file in WordPerfect, and replaces the markings with data
from Zenas databases about the current case, the one shown on the CaseView
sheet (or in some instances, the Bill sheet).  I have tried other methods of taking
data from QP into WordPerfect documents12 and find this to be the least
problematic.

Marked-up template files (.WPT) are stored in the C:\Cases\Zenas\Forms
folder.  You may alter them or add others.

The user invokes them from the CaseView screen, by pressing the [Case
Forms] button.  This runs the macro at Macs:E113, which in turn populates a list
of templates from which the user may choose.  If the user chooses one, the
program then merges that template with data in Zenas on that case using the
ZenasMerger.wcm macro.

How to mark a template for merging.

Zenas allows you to insert certain codes in the template in order to place data
from Zenas there.

Code in the template Action by ZenasMerger.wcm in the template

^CaseView:E3^ Types the content of CaseView:E3 (or any other
cell within the carets)

^#CaseView:D6^ Types the content of CaseView:D6, but the #
tells WP to retain the special numeric formatting
in that cell

^?Type your name^ Get keyboard input from the user, who is told to
“Type your name” in this example

^GETACTOR^ Selects an actor on the current case

^THISADDRESS^ After a person is selected with ^GETACTOR^,
this inserts the actor’s address

12 I consider this better than: (a) copy and paste/paste special; (b) using WordPerfect’s
Insert > Spreadsheet > Import/Update command; (c) using a PerfectScript macro to
completely build the document; and (d) WordPerfect’s Merge.  The last option was tried
in several different ways: (1) merging directly from Zenas as the data source; (2) merging
from one or more new QPW files created from Zenas; (3) merging from other types of
database file created from Zenas; and (4) merging from WordPerfect DAT files generated
by macro from some intervening file created from Zenas.
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^CLERKADDRESS^ Inserts the address of the person identified as
CLK

^ATTYNAMES^ Inserts a list of each person identified as ATT on
separate lines

^ATTYADDRESSES^ Inserts a list of all attorneys and their addresses

^ALLPLAINTIFFS^ Inserts a list of all persons identified as PLA

^ALLDEFENDANTS^ Inserts a list of all persons identified as DEF

^PASTE^ Pastes the current clipboard as unformatted text

^DATE^ Inserts today’s date

^SAVEFILE^ Zenas saves the current template with a file
name stored in Macs:B32

^GETTIME^ Takes time data from Bill sheet (used with
invoice template)

^GETCOSTS^ Takes costs data from Bill sheet (used with
invoice template)

How to add to/modify the list of templates.

The list of templates is stored on Macs:E130..E150.  There are currently 8
templates in that space, but if you need to make more than the 21 templates that
would fit in that range, you would need to extend the range in cell Macs:E113.

Templates are listed in a particular format in that range.  The name to be
displayed in the file picker is at the left, the file path and name are at the right,
and the two are separate by the caret ̂ .  That format allows Zenas to display one
and then use the other to open the desired file.
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V. Modifying Zenas.
The following discussions show how the user may modify the database to use

for his or her own purposes.

A. How to modify file locations

As noted above at p. 10, Zenas assumes that files are located in certain places. 
If I were attempting to change this system, which I do not recommend, I would do
the following:

1.  I would search the Macs page for every place where “c:” occurs, and change
the macro code accordingly.

2.  I would then open all of the Zenas macros and search for “c:”.  If found, they
would be changed as required.  I would also do the same for form files.

3.  In particular, I would need to completely re-think and perhaps substantially
re-write the ZenasClientFiles.wcm macro, which does most of the work of finding
the correct client folders.
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B. How to turn the display of grid lines and column headers
off and on.

For any worksheet, press [Ctrl+F12], which brings up the Sheet Properties
box.  (The menu selection Format > Sheet Properties does the same.) Select the
Display tab, and something like this picture will appear.  

To control whether column and row headers (i.e., A, B, C, or 1, 2, 3, respectively)
are shown, check or uncheck the Row and Column Borders boxes.  To control
whether grid lines are shown, check or uncheck the Horizontal and Vertical Grid
Lines boxes.
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C. How to resize the width of a column.

With the header row for columns displayed (e.g., A, B, C, etc.), move the mouse
cursor to the right edge of the header for the column to be displayed.  When it is
in position, the pointer will change to a vertical black line with arrows pointing to
the right or left.  When that happens, hold down the left mouse button and drag
left or right until the column has the desired width.
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D. How to change or deactivate informational messages.

Zenas adds quite a few informational messages to remind the user how to enter
data, not to press [Enter] until data is entered, and the like.  These could outlive
their utility, or you may prefer some other text in them.  Here is how to make
such changes.

First, locate the message on the Macs sheet.  You can do this either of two
ways.  First, almost all of the messages are stored in column A, beginning around
line 138, and you can scroll down the list.  Second, you can find the macro script
in question and track it down.  

For example, if you wanted to find the first informational message that occurs
when you push the [New Case] button on the CaseView page, right-click on the
button, choose Properties, and the Macro tab.  That will show where the macro
begins.  Go to that cell (currently Macs:E4) and read down until you find a call for
the informational message (currently in Macs:E16), which currently reads {alert
"New Case Follow-up",+Macs:B105,Macs:B10}.

To deactivate this informational message, you could either delete this text, or
better, deactivate it by putting a semi-colon at the start.  In this example, the
modified code would be {; alert "New Case Follow-up",+Macs:B105,Macs:B10}. 
The semi-colon tells QP not to enforce this command.  You can reactivate the
message simply by removing the semi-colon.

To change the message, you can edit the text in the {alert} command.  Where
the text is stored in a different cell, as in the above example, you would go to that
cell (in this case, Macs:B105) and edit it there.

To make multiline messages, after typing the text on one line, type Alt+Enter
to drop down to the next line in the same cell.

82



E. How to change the display of cases on the Zenas front
page.

This will explain how to change the display of cases on the Zenas main page,
and with any luck, it will give some insight into how to change other reports.

By right-clicking the [List Cases] button and choosing selection properties, we
see that the macro that controls the display of cases is located at Macs:c31.  We see
that the command at Macs:c32 runs the macro starting at Macs:c38 for every case
in the Cases database.  

C That macro stops when it gets to a blank cell (Macs:c39).  

C It doesn’t list cases with a Case# less than 1000, thus omitting pro bono cases
(Macs:c40).

C It places cases closed less than 90 days, it runs the series of commands at
Macs:c54..c56 that place data on the case into columns L..N on the Zenas front
page (Macs:c41).

C Other closed cases are ignored (Macs:c42).

C For other cases, if there is text in the Status column of the Cases Database
(which I use to mark the case as inactive or “as needed” or “standby”), the
macro runs the series of commands at Macs:c50..c52 that puts information into
columns I..K on the Zenas front page (Macs:c43). 

C If there is no text in the Status column, Zenas regards the case as fully active
and runs the commands at Macs:c46..c48 to put information into columns F..H
on the Zenas front page (Macs:c44).

Afterward, the macro does other things to format the display, but what was
just written gets at the logic of the macro and provides the framework for
changing it.  For example, assume that all of your open cases are “active” in some
sense, but you want to divide the display of cases between cases opened more than
one year ago, to be shown in columns F..H, and cases opened in the last year,
which will be shown in columns I..K.  If that is your goal, all you need to change
are the contents of cells Macs:c43 and c44:

C Instead of the offset of 9 in those cells, which tests what is in the Status
column, you would use an offset of 5, which tests what is in the D/Open
column.

C The test for whether a case is opened more than one year ago would be
whether the content of the cell in the D/Open column plus 365 is less than the
date returned by the @today function.  If so, it belongs in columns F..H;
otherwise, it belongs in columns I..K.

C Accordingly, you would change the contents of Macs:c43 (for columns I..K)
from:
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{if @index(Cases:a1..o10000,9,Macs:B13)<>""}{Macs:c50}{return}

to: {if @index(Cases:a1..o10000,5,Macs:B13)+365>=@today}{Macs:c50}
{return}

C Likewise, you would change  the contents of Macs:c44 (for columns F..H) from:

{if @index(Cases:a1..o10000,9,Macs:B13)=""}{Macs:c46}{return}

to: {if @index(Cases:a1..o10000,5,Macs:B13)+365<@today}{Macs:c46}
{return}

C You could adjust the number 365 to achieve greater balance.  Or you could use
other tests.
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F. How to write macros to pull information out of a Zenas
database, generally.

The basic tools for pulling data out of a Zenas database are the generic @Index
function and its more structured cousin, the @VLookup function.  @Index works
on any block of data forming a database, but the programmer has to supply the
column and row.  @Vlookup works on the narrower, but highly useful subset of
databases in which a unique index number for each row of data is in the first
column.

The three parameters of the @Index function are (a) the coordinates of the
database, (b) the column, and (c) the row.  The first two are almost always easy:
we determine what type of information we want, look at the database, find the
category of information that we want at the top of the database, and then count
the number of columns from the leftmost column.  So determining the row is
usually the only significant issue.

The most common way to determine the row is to use an @match function,
which has three parameters: (a) the number or text that you want to find in a
column of data, (b) the coordinates of the column of data (it can only be one
column), and (c) the type of match (Zenas uses zero to require an exact match). 
One limitation of @match is that if there is more than one match in the column,
it returns only the first it finds.  Therefore, it works reliably only on columns with
unique numbers, and therefore again, there is value to assigning unique numbers
to each case and person in the database, as in the Cases and People databases in
Zenas.

In generating reports from the database, the row is typically supplied by a
variable created by the {for} command, as explained below.

The @Vlookup function combines both the @index and @match functions for
many uses.  It takes four parameters: (a) the number or text that you want to find,
which will be used for determining the row, (b) the coordinates of the entire
database, (c) the column of information that you want, and the type of match
(which should again be zero for the uses that Zenas makes of databases). 
@Vlookup assumes that the number or text that you seek is in the leftmost
column, that the leftmost column is sorted, and that it has no blanks.  Several of
Zenas’s databases are structured in that way, so an @vlookup function is
marginally more efficient in those cases.
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G. How to write macros to report information from a Zenas
database, generally.

There are several ways to write data to cells in QP.  The most common method
used in Zenas is the {Let} command, which has two parameters: (a) the target
location, and (b) the data to write there.  {Let} is limited in that it cannot write
formulas; it can write a formula as a string or evaluate the formula and write what
the formula returns, but it cannot write a formula.13

Since we cannot know in advance where much of the data should be placed,
Zenas uses the @offset formula to place the data.  @offset has three parameters,
(a) the address of the top left cell of the report (or of the place on the report where
tabular data will be shown), (b) the number of rows below that initial address, and
(c) the number of columns to the right of that address.  Here again, we will know
the starting address of where the tabular data will appear because it is a specific
place in the Zenas notebook, and with column headings, we should know how
many columns to the right of that cell that we need to place the data.  Therefore,
again, the row is usually the only significant unknown.

To determine the correct row, Zenas usually uses the @count function, in
order to count the number of entries that are already in the leftmost column of
the report.  For example, in the Caseload Progress Report on the Deadlines page,
the tabular data starts at P3.  @count(Deadlines:P3..P1000) returns the number
of entries in that range.  If there are no entries, it returns a value of 0, which is
the offset to use for starting to print data at that point.  {let
@offset(Deadlines:P3,@count(Deadlines:P3..P1000),0),“First item of data”} will
thus put the “First item of data” into cell P3 on the Deadlines sheet.

A potential problem arises from using @count in that, once you use that macro
to put an entry into the first column, the number that @count returns increases
by one, so you can’t simply copy the @count formula to place entries on the same
row of the report.  Here are two solutions.  

(1) If the macro fills every cell in the report, you can use @count with each
column.  The next entry to the right might be {let @offset(Deadlines:P3,
@count(Deadlines:Q3..Q1000),1),“Second item of data”}.  This will not work well
if the report might be blank in certain cells.  

(2) Better, store the value of the @count function in a separate cell, and
then use that cell as the source of the row for each item to be put into the report. 
Hence, the macro may proceed:

{let Macs:B40,@Count(Deadlines:P3..P1000)}

13 In rare instances in which a formula must be placed in a cell, such as the Deadlines,
Zenas moves to the cell and uses a {putcell} command.
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{let @offset(Deadlines:P3,Macs:B40,0),“First item of data”}

{let @offset(Deadlines:P3,Macs:B40,1),“Second item of data”}

{let @offset(Deadlines:P3,Macs:B40,2),“Third item of data”}, and so on. 
Zenas uses the second approach most often.
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H. How to combine these techniques to write a report.

In the prior two sections, we discussed how to pull bits of information out of
Zenas database and then how to write a row of information into a report.  We now
put these together, using the {for} command, to search an entire database and
write a report on what you find.

The {for} command runs a series of macro commands a set number of times
(though it can be terminated earlier), and with each repetition being numbered. 
It has five arguments: (a) the cell where it stores the current number (or
“counter”); (b) the starting number; (c) the ending number; (d) the “step” number
(which will be 1 in these examples, but could be any other positive or negative
integer), and the address of the macro commands to be run on each occasion.  The
idea will be to go down each row in the database, from the starting row to the
ending row, and process a series of macro commands for each of those rows.

A typical starting command will be {for Macs:B13,1,10000,1,Macs:c39}. 
Explanation:

C Zenas typically uses Macs:B13 to store the counter of a {for} command.  

C The starting row is designated as 1 because the Zenas databases are structured
with text headers on the top row, with data starting on the next row.  The
@offset command treats the top row of headers as having an offset of 0,
whereas the first row of data has an offset of 1.  We start processing the macro
commands on that first row of data.

C The ending row is 10000, not because there are 10,000 rows that will need to
be processed, but because this is a number that is large enough to cover all
instances.  (Use a larger number if your entries are close to, or more than,
10,000.) The macro will contain the {forbreak} command to stop the repeti-
tions when there is no more data to process.

C The step variable is 1, meaning that on the first repetition, we will process row
1; on the second, row 2; on the third, row 3, etc.  (Note that it is sometimes
useful to process backward from the end, and then a -1 variable is useful, after
setting the starting number as the high one and the ending number as the low
one.  There are also instances in which a number like 2 would be useful, such
as to process only even-numbered rows.)

C In this instance Macs:c39 is the location of the commands to process; any other
location could be specified.  It should be separated from the commands
containing the {for} command so that they are not inadvertently processed
again.

Turning to the commands to be processed, which will begin at Macs:c39 in this
example, it is common to start with a test for the condition that will end the {for}
loop command.  The commonest case will be when the data run out in the leftmost
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column of the database, but other and multiple tests can be coded.  Hence, if we
are running down the cases database and intend to stop the loop when we reach
a blank in the leftmost column, this works:

{if @index(Cases:a1..o10000,0,Macs:B13)=""}{forbreak}

The next set of one or more commands will typically be to test for conditions
that don’t stop the {for} loop running altogether, but that stop it running for this
particular row.  In other words, if there is some fact about this row that makes us
want to ignore it, we test for that condition and, if it is true, add a {return}
command, which returns the processing to the command (here a {for} command)
that initiated it.  For instance, if we want to ignore rows where the case number
is less than 1000, this command works:

{if @index(Cases:a1..o10000,0,Macs:B13)<1000}{return}

After setting all the tests for stopping the {for} loop or ignoring the current
row of the Zenas database, then we write commands for taking data on the
current row (using @index or @vlookup functions), and writing it (or writing the
result of manipulating it in some way) into a report with {let} commands that use
an @offset function to determine where the data will be written.  The details of
doing so were addressed in the last two sections.  A typical set of commands might
be: 

{let Macs:B40,@Count(NewReport:A2..A1000)} 

which sets the row for the report at Macs:B40

{let @OFFSET(NewReport:A2,Macs:B40,0),@index(Cases:a1..o10000,0,Macs:B13)}

which takes the leftmost item of data (offset of 0) in the Cases database on the
current row (which is set in Macs:B13), and without manipulating it, places it in
the leftmost column (offset of 0) in the cell that is below NewReport:A2 by the
number contained in Macs:B40 (which can be 0).  This basic format can be copied
into subsequent macro commands and then altered for other columns of the
report, simply by (a) altering the column offset of the report, (b) altering the
column offset in the Cases database, and perhaps (c) manipulating the data
extracted from the Cases database before writing it.
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I. An alternative method for writing reports

The method just given tests every row in a database, one at a time.  That
method works, but Zenas also uses an alternative, possibly quicker, method in
cases involving a small subset of rows that aren’t contiguous.  Examples are
entries for a particular case in the Time or Costs databases, and entries for a
particular person in the Actor and Lawyers databases.  Instead of checking every
line, Zenas uses an @match function to find each entry, while skipping over non-
matching entries in one step.  This is complicated by the facts that:

C @match finds only the first match in a database.  In order to use it repeatedly,
Zenas must change the coordinates of the database, so that it searches a second
time in rows after the first match.  It changes both the coordinates of the
column in which the @match search takes place, and the coordinates of the
database as a whole, so that each start on the row following the last find.

C The variable coordinates cannot be hard-coded into the macro, and the @offset
function – which is the most usual way to generate coordinates with variables
– cannot be used to supply the coordinates as the first argument of an @index
function (an ERR results).

You can study the details in those macros, but the key trick is to calculate the
new coordinates of the column to be searched in the database and entering those
into a cell, say Z1, calculating the new coordinates of the database and entering
those in cell Z2, and then using an @@ function to refer to the coordinates.  Thus,
an @match function searching for a number that is stored in Z3, and storing in
cell Z4 the offset row on which it is found, takes this form:

{let Z4,@match(Z3,@@(Z1),0)}

And an @index function can then take, say, information from the third column
to the right of the left-most column in the re-calculated database and store it in
cell Z5, as follows:

{let Z5,@index(@@(Z2),3,Z4)}

90



J. Macro programming in Quattro Pro and PerfectScript.

These are not the only ways to read and write data to Zenas databases.  I have
prepared a “Cheat Sheet” for a variety of ways to automate QP programming. 
You may download the file at this URL:

http://corklaw.com/Tech/Zenas/QP_CheatSheet.wpd.
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K. How to change the structure of the Zenas databases.

It is entirely conceivable that you may want to track more information on, say,
cases and people than the fields available in the Cases and People databases
currently allow.  You can restructure those, or other databases, the macros that
relate to them, and the search/report fields that draw information from them.  I
do not recommend doing so unless you definitely need to do so, since repro-
gramming macros is likely.  I certainly do not recommend changing the order of
fields that you use, since many of the macros count on information being in a
certain column, and to get the same results, you would have to go through all of
the pertinent macros, understand them, and change them.

For instance, the Cases database is programmed to refer to the cells at
Cases:a1..o10000.  If you have more than 10000 clients, you would need to find
every reference to the Cases:a1..o10000 and change the latter reference to some
higher number, such as o20000.  If you need to add three more information fields,
you would need to change the latter reference to r10000.  You would need to do
this at every place you find “Cases:a1..o10000” and change it.  This is likely to
involve the Macs page and several formulas.

If you need to add to Zenas databases, here is what I would do:

1.  Add the columns you need to the existing columns, rather than re-shuffling
existing columns.

2.  Find every reference to the existing database on the Macs page, in the
PerfectScript macros, and in formulas at various spots in Zenas.  Change them to
embrace the new columns.
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